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Copyright © Tektronix. All rights reserved. Licensed software products are owned by Tektronix or its subsidiaries or suppliers, and are
protected by national copyright laws and international treaty provisions.

Tektronix products are covered by U.S. and foreign patents, issued and pending. Information in this publication supersedes that in all
previously published material. Specifications and price change privileges reserved.

TEKTRONIX and TEK are registered trademarks of Tektronix, Inc.
Planar Crown is a registered trademark of Aeroflex Inc.
LTE is a trademark of ETSI.

Bluetooth is a registered trademark of Bluetooth SIG, Inc.

Contacting Tektronix

Tektronix, Inc.

14150 SW Karl Braun Drive
P.O. Box 500

Beaverton, OR 97077

USA

For product information, sales, service, and technical support:
= In North America, call 1-800-833-9200.
= Worldwide, visit www.tek.com to find contacts in your area.


http://www.tek.com/contact

Warranty

Tektronix warrants that this product will be free from defects in materials and workmanship for a period of one (1) year from the date of
shipment. If any such product proves defective during this warranty period, Tektronix, at its option, either will repair the defective
product without charge for parts and labor, or will provide a replacement in exchange for the defective product. Parts, modules and
replacement products used by Tektronix for warranty work may be new or reconditioned to like new performance. All replaced

parts, modules and products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period
and make suitable arrangements for the performance of service. Customer shall be responsible for packaging and shipping the
defective product to the service center designated by Tektronix, with shipping charges prepaid. Tektronix shall pay for the return of the
product to Customer if the shipment is to a location within the country in which the Tektronix service center is located. Customer shall
be responsible for paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and
care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting from attempts by personnel
other than Tektronix representatives to install, repair or service the product; b) to repair damage resulting from improper use or
connection to incompatible equipment; ¢) to repair any damage or malfunction caused by the use of non-Tektronix supplies; or

d) to service a product that has been modified or integrated with other products when the effect of such modification or integration
increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY OTHER WARRANTIES,
EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX' RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS
IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX
AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH
DAMAGES.
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Important safety information

Important safety information

This manual contains information and warnings that must be followed by the user for safe operation and to keep the
product in a safe condition.

To safely perform service on this product, additional information is provided at the end of this section. (See page v,
Service safety summary.)

General safety summary

Use the product only as specified. Review the following safety precautions to avoid injury and prevent damage to this product
or any products connected to it. Carefully read all instructions. Retain these instructions for future reference.

Comply with local and national safety codes.

For correct and safe operation of the product, it is essential that you follow generally accepted safety procedures in addition
to the safety precautions specified in this manual.

The product is designed to be used by trained personnel only.

Only qualified personnel who are aware of the hazards involved should remove the cover for repair, maintenance, or
adjustment.

Before use, always check the product with a known source to be sure it is operating correctly.
This product is not intended for detection of hazardous voltages.
Use personal protective equipment to prevent shock and arc blast injury where hazardous live conductors are exposed.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

When incorporating this equipment into a system, the safety of that system is the responsibility of the assembler of the system.

To avoid fire or personal injury
Use proper power cord. Use only the power cord specified for this product and certified for the country of use.

Do not use the provided power cord for other products.

Ground the product. This product is grounded through the grounding conductor of the power cord. To avoid electric
shock, the grounding conductor must be connected to earth ground. Before making connections to the input or output
terminals of the product, make sure that the product is properly grounded.

Do not disable the power cord grounding connection.

Power disconnect. The power cord disconnects the product from the power source. See instructions for the location. Do
not position the equipment so that it is difficult to disconnect the power cord; it must remain accessible to the user at all
times to allow for quick disconnection if needed.

Connect and disconnect properly. Do not connect or disconnect probes or test leads while they are connected
to a voltage source.

Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult
the product manual for further ratings information before making connections to the product.
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Important safety information

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.

The measuring terminals on this product are not rated for connection to mains or Category I, IlI, or IV circuits.

Do not operate without covers. Do not operate this product with covers or panels removed, or with the case open.
Hazardous voltage exposure is possible.

Avoid exposed circuitry. Do not touch exposed connections and components when power is present.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected by
qualified service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged or operates incorrectly. If in doubt about safety of
the product, turn it off and disconnect the power cord. Clearly mark the product to prevent its further operation.

Before use, inspect voltage probes, test leads, and accessories for mechanical damage and replace when damaged.
Examine the exterior of the product before you use it. Look for cracks or missing pieces.

Use only specified replacement parts.
Wear eye protection. Wear eye protection if exposure to high-intensity rays or laser radiation exists.

Do not operate in wet/damp conditions. Be aware that condensation may occur if a unit is moved from a cold to a
warm environment.
Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry. Remove the input signals before you clean the product.

Provide proper ventilation. Refer to the installation instructions in the manual for details on installing the product
so it has proper ventilation.

Slots and openings are provided for ventilation and should never be covered or otherwise obstructed. Do not push objects
into any of the openings.

Provide a safe working environment. Always place the product in a location convenient for viewing the display
and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads. Improper or prolonged keyboard or pointer use
may result in serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an ergonomics professional to avoid stress
injuries.

Use care when lifting and carrying the product. This product is provided with handles for lifting and carrying.

c WARNING. The product is heavy. To reduce the risk of personal injury or damage to the device get help when lifting or
carrying the product.

Use only the Tektronix rackmount hardware specified for this product.
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Important safety information

Service safety summary

The Service safety summary section contains additional information required to safely perform service on the product. Only
qualified personnel should perform service procedures. Read this Service safety summary and the General safety summary
before performing any service procedures.

To avoid electric shock. Do not touch exposed connections.

Do not service alone. Do not perform internal service or adjustments of this product unless another person capable of
rendering first aid and resuscitation is present.

Disconnect power. To avoid electric shock, switch off the product power and disconnect the power cord from the mains
power before removing any covers or panels, or opening the case for servicing.

Use care when servicing with power on. Dangerous voltages or currents may exist in this product. Disconnect
power, remove battery (if applicable), and disconnect test leads before removing protective panels, soldering, or replacing
components.

Verify safety after repair. Always recheck ground continuity and mains dielectric strength after performing a repair.

Terms in this manual

These terms may appear in this manual:

c WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

c CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Symbols and terms on the product

These terms may appear on the product:

B DANGER indicates an injury hazard immediately accessible as you read the marking.

®  WARNING indicates an injury hazard not immediately accessible as you read the marking.

B CAUTION indicates a hazard to property including the product.

A When this symbol is marked on the product, be sure to consult the manual to find out the nature of the
potential hazards and any actions which have to be taken to avoid them. (This symbol may also be used to
refer the user to ratings in the manual.)

The following symbol(s) may appear on the product;

A @ + b

CAUTION Protective Ground .
Refer to Manual ~ (Earth) Terminal Chassis Ground  Standby
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Compliance information

Compliance information

This section lists the EMC (electromagnetic compliance), safety, and environmental standards with which the instrument
complies.

EMC compliance
EC Declaration of Conformity - EMC

Meets intent of Directive 2004/108/EC for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

vi

EN 61326-1 2006, EN 61326-2-1 2006. EMC requirements for electrical equipment for measurement, control, and
laboratory use. 123

CISPR 11:2003. Radiated and conducted emissions, Group 1, Class A
I[EC 61000-4-2:2001. Electrostatic discharge immunity

|EC 61000-4-3:2002. RF electromagnetic field immunity

IEC 61000-4-4:2004. Electrical fast transient / burst immunity

IEC 61000-4-5:2001. Power line surge immunity

IEC 61000-4-6:2003. Conducted RF immunity &

IEC 61000-4-11:2004. Voltage dips and interruptions immunity 4, 7

EN 61000-3-2:2006. AC power line harmonic emissions

EN 61000-3-3:1995. Voltage changes, fluctuations, and flicker

European contact.

Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic interference.
Emissions which exceed the levels required by this standard may occur when this equipment is connected to a test object.
For compliance with the EMC standards listed here, high quality shielded interface cables should be used.

At the IEC 61000-4-11 Voltage-Interruption Transient Immunity test at 0% for 250 cycles, the EUT reboots and can take greater
than 10 seconds to recover.

Performance degradation information for the IEC 61000-4-3 test: Residual spurious signals can typically increase to -55 dBm with
exposure to the disturbance levels of this test.

Performance degradation information for the IEC 61000-4-6 test: Residual spurious signals can typically increase to the worse of
either 55 dB below reference level or -75 dBm, with exposure to the disturbance levels of this test.

Performance Criterion C applied at the 70%/25 cycle Voltage-Dip and the 0%/250 cycle Voltage-Interruption test levels (IEC
61000-4-11).
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Compliance information

Australia / New Zealand Declaration of Conformity — EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

®  CISPR 11:2003. Radiated and Conducted Emissions, Group 1, Class A, in accordance with EN 61326-1:2006 and
EN 61326-2-1:2006.

Australia / New Zealand contact.

Baker & McKenzie

Level 27, AMP Centre

50 Bridge Street

Sydney NSW 2000, Australia

Safety compliance

This section lists the safety standards with which the product complies and other safety compliance information.

EU declaration of conformity — low voltage
Compliance was demonstrated to the following specification as listed in the Official Journal of the European Union:
Low Voltage Directive 2006/95/EC.

m EN61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use — Part
1: General Requirements.

U.S. nationally recognized testing laboratory listing

m UL 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use — Part
1: General Requirements.

Canadian certification

B CAN/CSA-C22.2 No. 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory
Use — Part 1: General Requirements.

Additional compliances

® |[EC61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use — Part
1: General Requirements.

Equipment type

Test and measuring equipment.

Safety class

Class 1 - grounded product.
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Compliance information

Pollution degree descriptions

A measure of the contaminants that could occur in the environment around and within a product. Typically the internal
environment inside a product is considered to be the same as the external. Products should be used only in the environment
for which they are rated.

m  Pollution degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally
encapsulated, hermetically sealed, or located in clean rooms.

B Pollution degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is
caused by condensation must be expected. This location is a typical office/home environment. Temporary condensation
occurs only when the product is out of service.

m Pollution degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation.
These are sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct
sunshine, rain, or direct wind.

B Pollution degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical
outdoor locations.

Pollution degree rating
Pollution degree 2 (as defined in IEC 61010-1). Rated for indoor, dry location use only.

Measurement and overvoltage category descriptions

Measurement terminals on this product may be rated for measuring mains voltages from one or more of the following
categories (see specific ratings marked on the product and in the manual).

B Category II. Circuits directly connected to the building wiring at utilization points (socket outlets and similar points).
= Category lll. In the building wiring and distribution system.

m  Category IV. At the source of the electrical supply to the building.

NOTE. Only mains power supply circuits have an overvoltage category rating. Only measurement circuits have a
measurement category rating. Other circuits within the product do not have either rating.

Mains overvoltage category rating

Overvoltage category Il (as defined in IEC 61010-1).
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Compliance information

Environmental considerations

This section provides information about the environmental impact of the product.

Product end-of-life handling

Observe the following guidelines when recycling an instrument or component:

Equipment recycling. Production of this equipment required the extraction and use of natural resources. The equipment
may contain substances that could be harmful to the environment or human health if improperly handled at the product’s
end of life. To avoid release of such substances into the environment and to reduce the use of natural resources, we
encourage you to recycle this product in an appropriate system that will ensure that most of the materials are reused

or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according
to Directives 2012/19/EU and 2006/66/EC on waste electrical and electronic equipment (WEEE) and
batteries. For information about recycling options, check the Support/Service section of the Tektronix Web
site (www.tektronix.com).

Perchlorate materials. This product contains one or more type CR lithium batteries. According to the state
of California, CR lithium batteries are classified as perchlorate materials and require special handling. See
www.dtsc.ca.gov/hazardouswaste/perchlorate for additional information.

Restriction of hazardous substances

This product is classified as an industrial monitoring and control instrument, and is not required to comply with the substance
restrictions of the recast RoHS Directive 2011/65/EU until July 22, 2017.

RSA5100B Series Quick Start User Manual ix


http://www.dtsc.ca.gov/hazardouswaste/perchlorate

Preface

Preface

This manual describes the installation and basic operation of the RSA5100B Series Real-Time Signal Analyzers. For more
detailed information, see the instrument help.

= RSA5103B
B RSA5106B
m RSA5115B
B RSA5126B

Key Features
The RSA5100B Series is a family of high-performance real-time signal analyzers. Key features include:
®  Reduce Time-to-Fault and increase design confidence with Real-time Signal Processing
®  Swept DPX spectrum enables unprecedented signal discovery over full frequency range

®m  Advanced DPX including swept DPX, gap-free DPX spectrograms, and DPX zero span with real-time amplitude,
frequency, or phase

= DPX density™ trigger on frequency domain events and distinguish between continuous signals vs infrequent events
B Advanced time-qualified, runt, and frequency-edge triggers act on complex signals as brief as 20 ns

m 25,40, 85, 125, or 165 MHz acquisition bandwidths

B Acquire more than 5 seconds at 165 MHz bandwidth

= Wideband preselection filter provides image free measurements in entire analysis bandwidth up to 165 MHz

B Measurements including channel power, ACLR, CCDF, OBW/EBW, spur search, EMI detectors

®  Amplitude, frequency, phase vs. time, DPX spectrum, and spectrograms

B Correlated multi-domain displays

X RSA5100B Series Quick Start User Manual



Preface

Documentation

The following documentation is available for your Tektronix RSA5100B Series Signal Analyzers. For the most current
documentation, refer to the Tektronix Web site.

To read about

Use these documents

Installation and operation
(overviews)

Quick Start User Manual

The quick start user manual contains general information about how to put your instrument
into service and guides to user interface controls. This manual is available in printed
form and as a PDF file.

English, Tektronix part number 071-3224-XX.

Japanese, Tektronix part number 071-3225-XX.
Simplified Chinese, Tektronix part number 071-3226-XX.
Russian, Tektronix part number 071-3227-XX.

In-depth operation and
user interface help

Instrument help
The instrument help contains detailed information about how to operate the instrument.
The help is available as a PDF file.

Tektronix part number 077-0899-XX.

Application examples

Application Examples Manual
This manual provides practical examples of using the analyzer to accomplish tasks. This
manual is available as a PDF file.

Tektronix part number 071-3283-XX.

Programming commands

Programmer Manual
This manual contains descriptions of programming commands and their use. This manual
is available as a PDF file.

Tektronix part number 077-0901-XX.

Specifications and
performance verification

Specifications and Performance Verification Manual
This manual contains the instrument specifications and a procedure to check instrument
performance against warranted characteristics. This manual is available as a PDF file.

Tektronix part number 077-0900-XX.

User service

Service Manual

This manual provides a list of replaceable parts, care and maintenance information, and
information for servicing the instrument to the module level. This manual is available
as a PDF file.

Tektronix part number 077-0903-XX.

Data security

Declassification and Security Instructions
This document helps customers with data security concerns to sanitize or remove memory
devices. This document is available as a PDF file.

Tektronix part number 077-0902-XX.

RSA5100B Series Quick Start User Manual
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Preface

Software Upgrades

Software option upgrades are available. Software upgrades for options become operational only after you enter a valid
option key for the specific analyzer model and serial number.

To check for upgrades:
1. Use your Web browser to go to www.tektronix.com/software.

2. Enter the product name (for example RSA5126B) to find available software upgrades.

Conventions Used in This Manual

The following icons are used throughout this manual:

Sequence Front panel Connect Network PS2 SVGA USB
Step power power

° DO OO OCE
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Installation

Installation

Before Installation

Unpack the instrument, and check that you received all items listed as Standard Accessories. Optional accessories and
instrument options are also listed in this section. Check the Tektronix Web site (www.tektronix.com) for the most current
information.

Standard Accessories

Your instrument comes with the following accessories: product documentation (listed below), power cord, USB keyboard,
USB mouse, and instrument front cover.

The RSA5103B and RSA5106B also includes a BNC-N adapter.
The RSA5115B also includes a type N female Planar Crown RF input connector.

The RSA5126B also includes a 3.5 mm female Planar Crown RF input connector.

Product Documentation

B RSA5100B Series Real-Time Signal Analyzers Quick Start User Manual.

m  RSA5100B Series Real-Time Spectrum Analyzers Application Examples Manual
B RSA5100B Series Product Documentation CD.

Power Cords

The analyzer is shipped with one of the following power cord options. Power cords for use in North America are UL listed
and CSA certified. Cords for use in areas other than North America are approved by at least one authority acceptable in
the country to which the product is shipped.

International Power Plugs

®  Opt. AO - North America power

= Opt. A1 - Universal EURO power

E  Opt. A2 - United Kingdom power

H  Opt. A3 - Australia power

®  Opt. A4 -240V, North America power
B Opt. A5 - Switzerland power

m  Opt. A6 - Japan power

®  Opt. A10 - China power

®  Opt. A11 - India power

RSA5100B Series Quick Start User Manual 1



Installation

®  Opt. A12 - Brazil power

= Opt. A99 - No power cord

Optional Accessories

Options

RTPA2A - Real-Time Spectrum Analyzer Probe Adapter; Supports TekConnect probes P7225, P7240, P7260, P7313,
, P7330, P7340A, P7350, P7350SMA, P7360A, P7380A, P7380SMA, P7500 Series.

SignalVu-PC - Offline analysis software based on the RSA5000/6000 Series platform.

P7313SMA

RSAVu -0

ffline analysis software based on the RSA3000 platform for analysis supporting 3G wireless standards

Planar Crown 3.5 mm female connector, Tektronix part number 131-9062-00.

Planar Crown 3.5 mm male connector, Tektronix part number 131-8822-00.

Planar Crown Type N female connector, Tektronix part number 131-4329-00.

Planar Crown SMA female connector, Tektronix part number 131-8689-00.
Transit Case — Tektronix part number 016-1963-00.
Rackmount Retrofit - RSA56KR.

You can add the following options to your analyzer:

Option 09 -
Option 10 -
Option 11 -
Option 12 -
Option 14 -
Option 20 -
Option 21 -
Option 22 -
Option 23 -
Option 24 -
Option 25 -
Option 26 -
Option 27 -
Option 28 -
Option 29-
Option 32 -

Adds Enhanced Real Time.

Adds AM/FM/PM and Audio Analysis.

Adds Phase Noise and Jitter Measurement.

Adds Settling Time Measurement (Frequency and Phase).
Adds Noise Figure and Gain Measurement.

Adds advanced signal analysis (including pulse measurements).
Adds general-purpose digital modulation analysis.

Adds flexible OFDM analysis.

Adds WLAN 802.11a/b/g/j/p analysis.

Adds WLAN 802.11n analysis.

Adds WLAN 802.11ac analysis.

Adds APCO P25 measurement application.

Adds Bluetooth® LE and Bluetooth® Basic Rate RF transmitter measurements.

Adds LTE™ Downlink (Base Station) RF transmitter measurements (includes Cell ID).

Adds Bluetooth® 5 transmitter measurements.

Adds EMI Pre-compliance and troubleshooting.

RSA5100B Series Quick Start User Manual
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m  Option B25 - Adds 25 MHz real-time capture bandwidth (no cost option).

®  Option B40 - Adds 40 MHz real-time capture bandwidth.

= Option B85 - Adds 85 MHz real-time capture bandwidth.

B QOption B16x - Adds 165 MHz real-time capture bandwidth.

®  Option 50 - Adds 1 MHz to 3/6.2 GHz Pre-Amplifier (RSA5103B/RSA5106B only).

B Option 51 - Adds 1 MHz to 15/26.5 GHz Pre-Amplifier (RSA5115B/RSA5126B only).
m  QOption 53 - Adds Memory, 4 GB Acquisition Memory Total.

B QOption 54 - Adds Signal survey and classification.

= Option 65 - Adds Digital | and Q outputs.

B Qption 66 - Adds Zero-span output.

m  QOption 6566 - Adds Digital | and Q outputs and Zero-span output.

B QOption 300- Adds high performance real time DPX

= Qption B85HD- Adds high dynamic range, 85 MHz acquisition bandwidth

B Option B125- Adds 125 MHz acquisition bandwidth

= Option B125HD- Adds high dynamic range, 125 MHz acquisition bandwidth

B QOption B16xHD- Adds high dynamic range, 165 MHz acquisition bandwidth

= QOption MAP - Adds mapping capability.

B Option PFR - Adds Precision Frequency Reference.

= Option PFR50 - Adds Precision Frequency Reference and Internal Preamp (RSA5103B/RSA5106B only).

B QOption WINTOREM - A removable solid-state drive. Minimum disk capacity is 480 GB. The Windows 10 operating
system and instrument software is preinstalled.

= QOption WIN1ORINT - An internally mounted drive. Minimum disk capacity is 480 GB. The Windows 10 operating
system and instrument software is preinstalled.

®  RSA56KR - Rackmount for RSA5100A/B Series, SPECMON/B Series, and RSA6100B Series analyzers.

RSA5100B Series Quick Start User Manual 3
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Upgrades

Windows 7

= RSA5BUP Option SSD; Adds an additional removable solid-state drive for units equipped with Option 56. The Windows
7 operating system and instrument software is preinstalled.

B RSA5BUP Option 56; An internal solid-state drive. The Windows 7 operating system and instrument software is
preinstalled.

Windows 10

® RSA5BUP SPARE-WIN10 — Adds an additional removable solid-state hard drive. Windows 10 and instrument software
pre-installed.)

B RSA5BUP WIN10REM — A removable solid-state drive. The Windows 10 operating system and instrument software is
preinstalled.

B RSA5BUP WIN1OINT - An internally mounted drive. The Windows 10 operating system and instrument software is
preinstalled.

NOTE. Windows 10 requires activation to operate in Activated mode. (See page 6, Activating Microsoft Windows 10.)

4 RSA5100B Series Quick Start User Manual
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Operating Considerations

Power supply requirements

Source voltage and frequency

Power consumption

100 — 240 Vrys, 50/60 Hz
115 VRMS, 400 Hz

450 W maximum (all models)

Environmental requirements

Characteristic

Description

Operating temperature

+10 °C to +40 °C

Non-operating temperature

-20 °C to +60 °C

Humidity
Operating +40 °C at 95% relative humidity, meets intent of EN 60068-2-30.
Frequency amplitude response may vary up to +3 dB at +40 °C and greater
than 45% relative humidity.
Altitude:
Operating Up to 3000 m (9843 ft)

Non-operating

12190 m (40,000 ft)

Cooling clearance
Bottom
Sides and back

20 mm (0.79 in)
50 mm (1.97 in)
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CAUTION. To ensure proper cooling, do not operate the instrument on its side. Operate the instrument only when it is
resting on its bottom feet or rear feet. Maintain at least 2 inches (5 cm.) clearance around ventilation openings.

WARNING. To avoid personal injury, take extra care when lifting or moving the signal analyzer. The instrument is heavy and

requires extra care when moving it.
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Connecting to the Instrument

Connecting to a Network

Connect your keyboard, mouse, printer, and other accessories to your instrument before applying power. (Accessories with
USB connectors can be connected before or after applying power.)

You can connect your instrument to a ‘
network for printing, file sharing, Internet
access, and other functions. Consult your
network administrator and use the standard
Windows utilities to configure the instrument
for your network.

2838016

Quick Tip

= |f you connect your instrument to a network, you should protect your instrument by using an internet firewall, installing
regular approved operating system updates, and using up-to-date antivirus software.

Activating Microsoft Windows 10

The version of Microsoft Windows 10 that ships with this product is shipped in Deferred Activation mode. Microsoft has
a default activation method that requires a connection to the Internet. If you do not have a connection, you can activate
Windows 10 by phone or you can continue to operate in Deferred Activation mode.

First time activation
You can activate Windows 10 two ways.

1. Connect to the Internet. Windows will automatically activate. You can also go to System Properties to connect and
activate.

2. Call Microsoft and speak with a representative to activate Windows 10. Contact information and a unique activation
code (installation ID) will appear in a pop up window.

Activation with removable drives

If the SSD is removed from one analyzer and inserted into another analyzer, then the activation process will need to run
again. If analyzer 2 is not connected to the Internet, the activation will fail and an Activate Windows watermark will display on
the screen. To activate Windows and remove the watermark, you must connect to the Internet or call Microsoft.

6 RSA5100B Series Quick Start User Manual
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Powering On the Instrument
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Removing the Power

a,% @

2838019

CAUTION. Do not remove the power cord while the instrument is running. Power off the instrument first, allowing the
instrument to completely shut down before removing the power cord. The fans stopping is a good indicator.
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Adding an External Monitor

Use the following procedure to add an external monitor for dual monitor configuration. Both the analyzer and the second

monitor must have the color set to True Color.

NOTE. The Windows navigation in the following procedure is based on the Windows 7 operating system. Navigation may
vary from these procedures if you have a Windows 10 operating system installed.

1.

2. Connect the external monitor to the

3. Power on the external monitor.

Power on the analyzer.

analyzer.
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4. Open the Windows Control Panel.

5. Double-click Intel(R) Graphics and
Media to open the Intel Graphics and
Media Control Panel.

6. Set the Display setting to Built-in
Display.

RSA5100B Series Quick Start User Manual
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Adjust your computer’s settings

¥ Action Center
b Backup and Restore
Credential Manager
[ Desktop Gadgets
B8 Display
Folder Options
o HomeGroup
Internet Options
F Mouse
& Parental Controls
[ Phone and Modem
B Realtek HD Audio Manager
#5 RemoteApp and Desktop Connections
@) Sync Center
[ Troubleshooting
-]

dows Defender

Nindows Update

() [+ Control Panel + All Control Panel tems »

Administrative Tools

B BitLocker Drive Encryption
2 Date and Time
& Device Manager
@ Ease of Access Center
A Fonts
& Indexing Options
@2 Keyboard
5= Network and Sharing Center
M Performance Information and Tools
3B Power Options
il Recavery
% Sound

ystem
82, User Accounts

&

Yindows Firewall

'\‘1”

Viewby: Smallicons ¥

=g AutoPlay

Ed Color Management

@ Default Programs

# Devices and Printers

FM Elo Touchscreen (32-bit)

4 Getting Started

B Intel(R) Graphics and Media
EZ Location and Other Sensors
2 Notification Area Icons

&l personalization

[ Programs and Features

# Region and Language

& Speech Recognition

ke Taskbar and Start Menu
B

8 Windows Mobility Center

dows CardSpace

| Display

(intel.
Intel®

Graphics and Media
Control Panel

General Settings
Multiple Displays
Color Enhancement
Custom Resolutions

Monitor / TV Settings

Options and Support

e

Color Depth

Refresh Rate

Scaling

Built-in Display

1024 x 768

32 Bit

Scale Full Screen
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Installation

7. Click Multiple Displays.

8. Set the Operating Mode to Clone

Displays or Extended Displays as PR Uy

preferred . Graphics and Media Operating Mode | Clone Displays -
Control Panel
Single Display l:l

| Primary Display
Display E‘. - .
—— EE o Dispiay + Clone Displays

General Settings

Multiple Displays » Extended Desktop Ei:l

Color Enhancement
Custom Resolutions

Monitor / TV Settings

Options and Support

9. If you select Extended Desktop, be sure
to set the Positioning to align the two
desktop displays. Intel®

Graphics and Media Operating Mode  Extended Desktop
Control Panel

Primary Display  Built-in Display
| Display E ‘ |
——— Second Display ~ Monitor

General Settings

Multiple Displays

Multiple Displays L Positioning.
Color Enhancement
Custom Resolutions

Monitor / TV Settings

Options and Support
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Adjusting the Windows Display Settings

To change the instrument display settings, use the Intel Graphics Driver instead of the default Windows display properties.
The Intel Graphics Driver provides additional capabilities that are not accessible from the Windows display properties

dialog box.

NOTE. The Windows navigation in the following procedure is based on the Windows 7 operating system. Navigation may
vary from these procedures if you have a Windows 10 operating system installed.

1. Open the Windows Control Panel.

2. Double-click Intel(R) Graphics and
Media to open the Intel Graphics and
Media Control Panel.

3. Adjust the settings as necessary.

P
() [ + Control Panel » All Control Panelltems »

Adjust your computer’s settings

¥ Action Center

W Backup and Restore

[E Credential Manager

& Deskiop Gadgets

B Display

Folder Options

& HomeGroup

Internet Options

F Mouse

& Parental Controls

[5] Phone and Modem

B Realtek HD Audic Manager
) RemoteApp and Desktap Connections
@ Sync Center

[ Troubleshosting

i Windows Defender

£} Windows Update

Administrative Tools
B BitLocker Drive Encryption
9 Date and Time
54 Device Manager
@ Ease of Access Center
A Fonts
&= Indexing Options
&3 Keyboard
¥ Network and Sharing Center
M Performance Information and Tools
B Power Options
& Recovery
% Sound
1B System
H, User Accounts

& Windows Firewall

~[4][ 5=

View by:  Small icons ~

[Eg AutoPlay

K4l Color Management

@ Default Programs

% Devices and Printers

fIM Elo Touchscreen (32-bit)

5| Getting Started

Intel(R) Graphics and Media
B Location and Other Sensors
33 Notification Area Icons

B personalization

[ Programs and Features

& Region and Language

& Speech Recagnition

L, Taskbar and Start Menu
B windows Cardspace

8 Windows Mobility Center

NOTE. Not all of the selections in the
property page will be available if there is no
external monitor connected to the instrument.

4, Click OK to apply the settings and to
close the properties page.
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intel.

Intel®
Graphics and Media
Control Panel

Display

General Settings 1
Multiple Displays

‘Color Enhancement

‘Custom Resolutions

Monitor f TV Settings

Options and Support

‘General Settings

Display

Resolution

Color Depth

Refresh Rate

Scaling

Built-in Display
1024 x 768

32 Bit

60 Hz

Scale Full Screen
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NOTE. You can attach a second monitor after the analyzer is powered on; however, after connecting, you will still need to

enable the Extended Desktop from the Intel Extreme Graphics 2M control panel.

Inspecting the Instrument

Run the diagnostics application (Tools > Diagnostics). If failures occur, perform the following steps to get more information
about them. You can also use the following steps as a detailed incoming inspection to verify the functionality of your
instrument. If you want to check the accuracy specifications of your instrument, see the RSA5100B Series Real-Time
Signal Analyzers Specifications and Performance Verification Technical Reference manual PDF located on the Product

12

Documentation CD.

1. Select Tools > Diagnostics.

2. On the Diagnostics tab, click All
Modules, All Tests.

3. Click Single Test.
4. Click RUN.

The instrument will run through the
tests one at a time. A check mark

or X'icon will appear to the right
of each check box as that test is

completed. The check icon means
the test was passed. An X means

the test has failed.

5. For tests that require manual

intervention, follow the on-screen
instructions to complete the tests.

Window Help

= Mask Search

Alignment

| Diagnostics

Install Upgrades...

Licenses

Options

f2 Signal Database...

£ RSAMap

Diagnastics | Power-On Self Tests

4 all Modules, All Tests
Hardware Init

Digital Interface Board
RF Interface

LOZ2_REF

Lo1

MFC LO

RF Converter

MFC 156G

MFC 266G

ADC

DPSA Board

Z5 RTIQ Output Board
Front Panel

Sweep Speed

dEdEEEEEEEEFEEE

TestProgress [ ]

RUN

Current Series
Count: 0
Date: 7/22/2016
Time: 1:25PM
Temp:

Repeat
_) Times: a
) Until Fail

_) Continuous

 Single Test

{ Exit Diagnostics

NOTE. Select the Diagnostics Failure Information tab to see basic diagnostic failure information. Use the Windows Event
Viewer (Control Panel > System and Security > Administrative Tools > Event Viewer) to view failure history and nondiagnostic

failures reported by the application.
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User Maintenance
Caring for the Planar Crown RF Input Connector (RSA5115B/RSA5126B Only)

The Planar Crown input connector consists of two parts. The first part is the Planar Bulkhead, which is mounted in the
instrument front panel. The second part of the input connector is the Planar Crown, which mates to the Planar Bulkhead. The
Planar Crown can be easily changed should the connector become damaged or a different connector type be required.

No tools are required to remove or install the Planar Crown connector. A reasonable hand tightening of the connector is
sufficient to ensure an excellent connection.

When changing connectors, be careful not to touch inner surfaces of the connector halves.

Use only a 75% isopropyl alcohol solution to clean the Planar Crown connector, if needed. Do not use tap water to clean the
connector. Do not submerge the connector in a cleaning solution. Do not use abrasive compounds to clean the connector.

Cleaning Your Instrument

Clean the exterior surfaces of the chassis with a dry lint-free cloth or a soft-bristle brush. If any dirt remains, use a cloth or
swab dipped in a 75% isopropyl alcohol solution. Use a swab to clean narrow spaces around controls and connectors. Do
not use abrasive compounds on any part of the instrument because they might damage the instrument.

CAUTION. Avoid getting moisture inside the instrument during exterior cleaning; use just enough moisture to dampen the

A cloth or swab. Do not wash the front-panel On/Standby switch. Cover the switch while washing the instrument. Use only
deionized or distilled water when cleaning. Use a 75% isopropy! alcohol solution as a cleanser and rinse with deionized
or distilled water. Do not use chemical cleaning agents; they might damage the chassis. Avoid chemicals that contain
benzene, toluene, xylene, acetone, or similar solvents.

CAUTION. To prevent damage to the flat panel display, do not use improper cleaning agents or methods. Avoid using
abrasive cleaners or commercial glass cleaners to clean the display surface. Avoid spraying liquids directly on the display
surface. Avoid scrubbing the display with excessive force.

Clean the display surface by gently rubbing the display with a clean-room wipe. If the display is very dirty, moisten the wipe
with distilled water or a 75% isopropyl alcohol solution and gently rub the display surface. Avoid using excess force; this
might damage the display surface.

RSA5100B Series Quick Start User Manual 13
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Upgrading the Instrument Software

Software upgrades are available by downloading them from the Tektronix Web site www.tektronix.com/software. To add
additional software options or features, you will need an option key from Tektronix. When you receive the option key from
Tektronix, follow the installation instructions provided with the upgrade.

Returning Your Instrument
If you return your instrument to Tektronix:
B Back up any user software on the hard disk. You may need to reinstall the software after your instrument is returned.

m  When repacking the instrument for shipment, use the original packaging. If the packaging is unavailable or unfit for use,
contact your local Tektronix representative to obtain new packaging.

®  Seal the shipping carton with an industrial stapler or strapping tape.
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Operation

Getting Acquainted with Your Instrument

Controls and display elements are shown in the following illustrations and tables.

Front Panel Controls

Most front panel controls are shortcuts for opening control panels.

O

Ji |

@(
“
|
|

Settings @

@ = @
=B e
Ref number Item Description Menu equivalent
1 Media Optional removable solid-state hard drive.
2 Displays Opens the Displays dialog box to select measurement Setup > Displays
displays.
3 Settings Opens the Settings control panel for the selected display. Setup > Settings
4 Trigger Opens the Trigger control panel. Setup > Trigger
5 Acquire Opens the Acquire control panel. Setup > Acquire
6 Analysis Opens the Analysis control panel. Setup > Analysis
7 Freq Adjusts the measurement frequency. Setup > Analysis >
Frequency tab
8 Span (Spectrum) Adjusts the span or frequency range shown in the Spectrum Setup > Settings >
display. ! Freq & Span'*!
9 Amplitude Adjusts the reference level. Setup > Amplitude
10 BW (Spectrum) Adjust the resolution bandwidth (RBW). 1 Setup >1Settings >
BW tab

1 Applicable only when the selected display is Spectrum, DPX Spectrum, or Spectrogram.

RSA5100B Series Quick St
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16

<9505 @
— e D\
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@ 2838-006
Ref number Item Description Menu equivalent
12 Run (Stop) Push to start and stop acquisitions. Run > Run
13 Markers, Peak Moves the active marker to the maximum peak of the trace
in the selected display. If markers are turned off, the MR
(marker reference) marker will appear at the maximum peak.
14 Markers, Select Selects the next marker.
15 Markers, Define Opens the Markers control panel. Markers > Define
Markers
17 Control knob Increments/decrements numbers with fine resolution.
18 Arrow keys Move the Markers. The Up arrow moves the selected
marker 10 trace points to the right. The down arrow moves
the selected marker 10 trace points to the left. The left and
right arrows move the selected marker to the next peak.
(Turning the knob moves the marker one trace point left or
right.)
19 Increment / Increments or decrements numbers with coarse resolution.
decrement keys
20 Markers, Delete Deletes the highest-numbered marker.
21 Markers, Add Adds a marker to the selected trace.
22 Replay Replays the current acquisition record.
23 Single Sets the Run mode to Single Sequence and initiates a single

sequence acquisition cycle.
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2838009

Ref number Item Description Menu equivalent
24 Keypad Enters values in controls.
25 Enter Completes the data entry in controls. Same as pressing the

Enter key on the keyboard.
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2838-002

Ref number Item Description Menu equivalent
26 Recall Opens the Recall dialog box. File > Recall
27 Save Saves working file using the same user selections as for the File > Save
previous Save action.
28 Touch Screen Off Turns the touch screen on and off.
29 Help Displays the online help. Help >
User Manual
31 Application Opens the Application preset dialog box. You can change Presets >
the effect of pressing Application using the settings at Application
Presets > Preset Options > Preset type/action.
32 DPX Opens a DPX display set to the same span as the spectrum Presets > DPX

display. If the spectrum display is not open, the span is set
to the last span of the spectrum display. You can change
the effect of pressing DPX using the settings at Presets >
Preset Options > Preset and Preset action.

33 User Opens the User preset dialog box. You can change the Presets > User
effect of pressing User using the settings at Presets > Preset
Options > Preset type/action.

34 Preset Resets the instrument to its factory default settings. Preset
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Front Panel Connectors
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Ref number Item Description
1 Trig Out Trigger output connector. 50 Q, BNC, High>2.0V, Low < 0.4 V, (output current 1 mA)
2 Trig In External Trigger input connector, 2.5 V to +2.5 V range,
trigger level is user adjustable
USB port USB 2.0 connector
USB port USB 2.0 connector
RF Input RF input connector 50 Q

+ 30 dBm (Pre-amp off)
+ 20 dBm (Pre-amp on)
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Rear Panel

R
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Ref number Connector, Description

1 AC Input, main power connector

2 GPIB

3 Zero Span Analog Out (Option 66)

4,5 Real Time | and Q Out (Option 65)

6 +28 VDC output, switched

7 Microphone in; Headphone, audio output; and Line In connectors (Line In not supported)
8 External Trigger 2 Input

9 COM 2, serial port for connecting peripherals

10 VGA external monitor output (resolution not limited to VGA)

" PS2 Keyboard input

12 USB 2.0 ports for mouse and other peripherals (printers, external hard disks)
13 Ref Out, reference frequency output

14 Ref In, reference frequency input

15 LAN, Ethernet 10/100/1000 Base T network connector

20 RSA5100B Series Quick Start User Manual



Operation

Interface and Display Elements

Commonly-used buttons and controls are located in the tool bar. Most of the buttons open control panels for changing the
instrument setups. The contents of the control panels vary depending on the selected display. You can also access the
control panels from the front panel buttons or from the keyboard.

(z) @@

E File View Ma.kei SeijlrfsEs l}ri -~ Window Help
@ EdeYFROUANMINS P @& »Repay v ORn v
Frequency vs Time D m
v +Peak Normal W| Time: 0.0
& 850 MHz Analysis [
-20.0
Offset:
8.000 us
-40.0
_ Position: Length:
% 211 kHz 100.000 us
-60.0
_ da/div: 80.0
-859 MHz “ 10.0d8
[ Autoscale | & postion: 8000 us "y scale: 100,000 us -100.0 - .
Max: 7812MHz @ 9.000us Min: 7812MHz @ 22.89us [Autoscale | = postion: 0.000's = Scale: 100.000 us
]
Overlap: 92 % +Peak Clear \ v Trace1 [¥IShow +Peak Normal Clear \
a.gr;eul(:':: ] 8/26/2008 19:16:29.221815 ~ adlaufldnwéa o0 =
KB RBW: -20.0
1.00 Mriz © 1.00 MHz
[ vBw: [ vBw: -40.0 -
30 60.0 -
80.0 - i
aPos:
1.9 dN h 4 Al X (0TSRRI AN v -100.0-
\ Autoscale | « CF: 1.000 GHz = Span: 1.000 GHz [Autoscale | & CF 1.000 GHz & 5pan 1.000 GHz
Freq Vs Time Frequency 1.000 GHz Ref Lev |-0.01 d8m Meas BW |1.000 GHz Markers Traces‘@‘
Stopped Warm-up period Real Tirﬁ-ﬂee Run Ref: Int ‘
\_/ 0720-004
Ref Setting Description
number
1 Recall Displays the Open window in order to recall setup files, acquisition data files,
or trace files.
2 Save Opens the Save As dialog in order to save setup files, pictures (screen
captures), acquisition data files, or export measurement settings.
3 Undo/Redo Undoes or redoes the previous edit to a display or measurement settings, a
preset, or a measurement change.
4 Displays Opens the Select Displays dialog box so that you can select measurement
displays.
5 Settings Opens the Settings control panel for the selected display. Each display has
its own control panel.
6 Trigger Opens the Trigger control panel so that you can define the instrument trigger

settings.

RSA5100B Series Quick Start User Manual
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Ref Setting Description
number
7 Acquire Opens the Acquire control panel, which displays the Sample Rate and Record
length of the recalled waveform file.
8 Analysis Opens the Analysis control panel so that you can define the analysis settings
such as frequency, analysis time, and units.
9 Amplitude Opens the Amplitude control panel so that you can define the Reference Level,
configure internal attenuation, and specify external gain/loss corrections.
10 GNSS/Antenna Opens the GNSS/Antenna control panel so that you can configure and activate
an external GNSS receiver and antenna.
" Favorite User Presets Click to select from a list of custom favorite User presets and load the selected
preset.
12 Main menu bar Located above the Favorites toolbar, it contains access to menus.
13 Preset Recalls the Main preset.
14 Replay Runs a new measurement cycle on the last acquisition data record using any
new settings.
15 Run ®  Run menu and Run/Stop toolbar
and Starts and stops data acquisitions and specifies the run conditions. For
Run/Stop toolbar example, if you select Single in the Run/Stop toolbar (or Run Single in the

Run menu), a single measurement cycle is run. If you select Continuous
in the Run/Stop toolbar (or Run Continuous in the Run menu), the data
acquisition runs until stopped.

= Run menu
The Run menu also includes Resume and Abort.

Resume restarts data acquisition, but does not reset accumulated results,
such as Average or MaxHold. This allows you to stop acquisitions
temporarily, then continue.

Abort immediately halts the current acquisition/measurement cycle.
In-process measurements and acquisitions are not allowed to complete.

22
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16 : The Edit Favorites icon allows you access the below menu, which allows you to
edit the contents of the Favorites bar.
lay » o v |
¢ Undo v
& Redo 4
5 Displays i
£¥ Settings =~
@ Trigger 4]
8 Acquisition o
i Analysis v
W Amplitude v
& GNSS/Antenna ¥
[T Favorite Preset [+
Reset
17 Reference Level Displays the reference level. To change the value, click the text and enter a

number using a keyboard, or use a mouse scroll wheel.

18 Frequency Displays the frequency at which measurements are made. For spectrum
displays, this is called “Center Frequency”. To change the value, click the
text and use the front panel knob to dial in a frequency. You can also enter
a frequency with the front panel keypad or use the front panel up and down
buttons.
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Display-Specific Controls

Most displays have commonly-used controls arranged around the graph. They provide quick access to common settings;
the full control set for the display is in the Settings control panel. The following illustration and table show some of the
common icons that appear in most displays.

@

< w
@ 0.00 dBm
@ ., dB/div:
10 dB
- RBW:
@ 1.00 MHz

Table 1: Common icons

Ref number Control icon

Trarel W Shrwr  +Pegk Mormal

Bitmap
Tracel

Enable Trace?
Enable Trace3
Enable Math

Description

1 o Drop-down List. Click to select a value from the drop-down list.

2 -] Knob. Click anywhere on the icon or on the text readout to select the control. You
can then change the value with the front panel control knob or arrow keys, or enter a
value from the keypad.

3 1.00 MHz Italicized numbers. These indicate automatically selected control values. Several

controls in the instrument (for example, RBW and Analysis Length) allow you to
select an Auto mode. In Auto mode, the instrument software automatically sets the
value. You can change the control to Manual mode by changing the value. To return
to Auto mode, clear the value, and then press the Enter key.
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Basic Concepts

Real Time Analyzers

Tektronix real-time analyzers have a frequency mask trigger. The frequency mask trigger allows you to set up a spectral
mask to capture a signal when a spectral anomaly occurs. This allows the analyzer to check 100% of the input signal before
acquiring, and then capture precisely the intermittent RF event of interest.

DPX™ technology allows you to view the RF signal as a live display. You can view very short transient signals, multilevel
signals, and time-varying events. You also have the ability to measure and trigger on signal density values in the DPX display.

The analyzers allow you to view the captured signals in a wide variety of time-correlated displays. This is useful for device
troubleshooting and signal characterization applications. All measurements are based on the same real-time data, however
the DPX display has a unique method for processing, storing, and displaying the data.

Measurement Displays

The analyzer window can show one or any combination of general purpose and application-specific displays.

This eXGmp'e shows a DPX SpeCtrUm Spllt [T File View Run Replay Markers Setup Presets Tools Window Help 8 x
display. A DPXogram display appears on the B S & & T % ™15 Freauency 15000GH Reflev 000 dm B | @ Replay - | Fun

top and a DPX Spectrum dISpIay appears on Replay: Acq Data A r WD Select All Select.. §# 1 10/24/2011 23:17:4.59

the bOttom o Time/div:

c AM1: 3.920 dB
2.50s -12.325 MHz
5898 s

Spectrums/line: 1

3-D

o Pos:
0.0 div

v DPXogram [¥|Show +Peak Clear
= 0.00 dBm
» dBfdwv:

10.0 dB
o RBW:
500 kHz

Split -

-100.00 dBm

Autoscale © CF: 1.5000 GHz & Span: 85.0 MHz
Stopped Not aligned Real Time  Free Run Ref: Int Atten: 15 dB
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This example shows the window with two
displays, a Spectrum display and a DPX
spectrum display.

When you have more than one display open,

the display with the check mark icon has
control over the acquisition hardware. To
give a display priority over any others, click
its title bar.

This example shows four displays in the
window.

[ Fie View Run Replay Markers Setup Presets Tools Window Help

] ® & T & & 1A | Frequency: 10000000 GHz  Reflewi 0.00 dBm

Fresel | & Replo 2 Step

[TV opx Spectrum

v Bitmap

===
] Show On =3
© 0.00 dBm
& dB/du:
10.0 dB
& RBW:
100 Kz

pmTae e
| Autoscale | = CF: 1.0000000 GHz

-100.00 dBm

© Span: 100.0 kHz

[T spectrum

v Tacel [Zshow +Peak Normal
© 0.00 dBm
o dB/div:
10.0 dB
o RBW:
1.00 ktiz
VBW:

‘\ u“
\H u

[ Autoscale | © CF: 1.0000000 GHz

Transfer Acq BW: 156.25 kHz, Acg Length: 2.501 ms

Real Tme _Free Run

Ref: Int _Atten: 25 dB

[[l Fle View Run Replay Markers Setup Presets Tools Window Help
[} @ % T = & [N Frequency: 10000000 GHz  Reflew: 0.00 dBm

[ Amplitude vs Time.

¥ Tacel [VIShow +Peak Normal [ clear
v -3.95dBm
o dBfdiv:
10.0 dB
= Span:
100.0 kHz

-103.95 dBm
[ Autoscale | il
RMS: -10.94dBm © Posttion: -1.116 ms
Max: -5.82 dBm @ -409.6us  Min: -45.18dBm @ 102.4us

© Scale: 2.232ms

[T oPx Spectrum

¥ Bitmap

¥Ishow On
© 0.00 dBm
o dBfdiv:
10.0d8
o RBW:
1,00 ktz.

-100.00 dBm © —
[[Autoscale | = CF: 1.0000000 GHz

X spectrogram S @)=

Spectrums/ine: 1

+Peak =

» Time/div:
111 ms
o RBW:
1,00 ktz.
vBW:

3D

= Pos:
0.0 dv

© Span: 100.0 kHz

.
[LAutoscale | = CF: 1.0000000 GHz

[T spectrum

v Tacel [@Show +Peak Nommal [ar]

© 0.00 dBm
o dBdiv:
10.0 dB

-100.00 dBm |

[_Autoscale

Transfer Acq BW: 156.25 kHz, Acq Length: 2.606 ms  Real Time Free Run

Ref: Int._ Atten: 25 dB

The acquisition data source can be a live acquisition or a saved acquisition data file. The sharing of acquisition data between
displays allows you to view the same data in multiple ways. For example, you can display a power versus frequency
(spectrum) display and a spectrogram diagram at the same time. Because the data source is shared among the different
displays, the displays are correlated. That is, a point or set of points within one display is associated with a point or set of
points in every other display in the application window.
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Navigating Displays

The analyzers use multiple displays to keep operations simple, and yet provide advanced functionality when needed. Some
of the display categories include:

General Signal Viewing displays. These displays show graphs for basic signal parameters such as amplitude, phase,
and frequency plotted against frequency or time. Examples of these displays include: Spectrum, DPX, Spectrogram,
Time Overview, and Phase vs Time.

Analog Modulation. These displays show graphs and measurements for Analog Modulation, Frequency Modulation,
and Phase Modulation.

General Purpose Digital Modulation displays. Available with Option 21. These displays show the results of
demodulating signals and analyzing them in multiple domains. Examples of these displays include: Constellation,
EVM vs Time, Eye, Symbol Table, and Trellis diagrams.

RF Measurements displays. Available with Option 11. These displays show the results of automated measurements on
RF signals. Examples of these displays include: ACPR, MCPR, Phase Noise, and CCDF.

OFDM Analysis. Available with Option 22. These displays provide OFDM analysis for WLAN 802.11alj/g and WiMax
802.16-2004 signals.

Advanced Pulse Analysis. Available with Option 20. These displays show the results of advanced analysis for pulsed
RF signals. Pulse-Ogram™ waterfall display of multiple segmented captures, with amplitude vs time and spectrum of
each pulse. Pulse frequency, Delta Frequency, Average on power, Peak power, Average transmitted power, Pulse width,
Rise time, Fall time, Repetition interval (seconds), Repetition interval (Hz), Duty factor (%), Duty factor (ratio), Ripple
(dB), Ripple (%), Droop (dB), Droop (%), Overshoot (dB), Overshoot (%), Pulse- Ref Pulse frequency difference, Pulse-
Ref Pulse phase difference, Pulse- Pulse frequency difference, Pulse- Pulse phase difference, RMS frequency error,
Max frequency error, RMS phase error, Max phase error, Frequency deviation, Phase deviation, Impulse response
(dB), Impulse response (time), Time stamp.

Audio Analysis. Available with Option 10. These displays measure basic time- and frequency-domain parameters
of analog audio signals modulated on a carrier (AM, FM and PM modulation) or unmodulated (non-carrier) audio
signals (Direct).

WLAN Analysis. Available with Options 23, 24, and 25. Each of these options provide OFDM analysis of WLAN802.11
standards. All three options combined provide analysis for WLAN802.11a/b/g/j/p/n/ac signals.

Bluetooth® LE and Bluetooth Basic Rate RF. Available with Option 27. Bluetooth LE (Low Energy) and Bluetooth
Basic Rate RF (Radio Frequency) provides 13 transmitter performance measurements for 10 different test setups in
compliance with Bluetooth RF PHY Test Specifications 4.1.1 and Radio Frequency (RF) Test Specifications 4.1.1.

APCO P25 Analysis. Available with Option 26. This complete set of push-button Telecommunication Industry
Association TIA-102 standard-based transmitter measurements includes modulation measurements, power
measurements, and timing measurements. These measurements are also compared with the limits that best fit the
signal for which the standard applies to provide pass/fail results.

LTE™ Downlink Analysis. Available with Option 28. LTE Downlink (Base Station) RF analysis provides transmitter
performance measurements for both TDD and FDD (for example, Channel Power, Occupied Bandwidth, ACLR,
SEM, Cell ID, and TDD LTE Transmit Power Off) in compliance with Test Specifications 36.104 (Base Station radio
transmission and reception) and 36.141 (Base Station conformance testing).

Signal Classification. Available with Option 54. The signal classification application enables expert systems guidance
to aid the user in classifying signals. It provides graphical tools that allow you to quickly create a spectral region of
interest, enabling you to classify and sort signals efficiently.
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®m Return loss. Available with Option 60. Provides return loss, VSWR, cable loss, and distance to fault measurements.

B Noise Figure. Available with Option 14. These displays measure the noise contributions in a system. Displays include
Noise Figure, Gain, Y-factor, Noise Temperature, Uncertainty Calculator, and tabular results. Single-frequency metering
and swept-trace results are available, as well as support for industry-standard noise sources. Measurements for amplifiers
and other non-frequency converting devices, and fixed local-oscillator up and down converters are also available.
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Selecting Displays

The analyzer provides an easy way to select displays.

1. Click the Displays icon to open the Select 2 Fie

) . View Markers Setup Presets Tools Window
Displays dialog box.

EHeYSOG DU MNS P
®

There are two ways to select displays: choose any combination of displays or use an Application Preset.

Choose any Combination of Displays. Select displays one by one as needed.

1. Click the desired application folder in the

Select Displays dlalog box. Choose any combination below, or use an Application Preset. ‘ Application Presets... ‘
The available displays for each folder are
listed in the Available Displays pane. Heasurements: , Awaiable displays:
2. Click one of the display icons. RE Measurements e vs  DPX Ry PhEﬁ?fevs
. . . Tracking Generator f
3. Click Add (or double-click the icon) to G Digtal Modulaton
. nalysis
add the selected display to the Selected Audio Analysis m
: H Bluetooth Analysis RFI&Q vs Spectrogram Time
displays list. Repeat the procedure to LTE Analsi o Ovame
add other displays. P25 Analysis
Pulsed RF
. . 802.11ad Analysis
4. Click OK to close the dialog box. The WLAN Analyss
. . eturn Loss
selected displays will open.

Selected displays:

Spectrum

[[J *Hide unpurchased measurements OK ‘ ‘ Cancel ‘
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Use an Application Preset. Select displays from the presets for your application.

1. Click Application Presets in the Select

Displays dialog box.

2. Use the pull down list to display the
presets.

NOTE. Some presets appear only if the
associated instrument option is installed.

3. Select a preset from the list.

Choose any combination below, or use an Application Preset. l Application Presets... l

Measurements: Available displays:

General Signal Viewing I8

Analog Modulation
GP Digital Modulation
RF Measurements

Amplitude vs DPX Frequency  Phase vs

OFDM Analysis = Time vs Time Time
Audio Analysis -

Bluetooth Analysis M

P25 Analysis .

Pulsed RF RFI&Q vs  Spectrum Time

WLAN Analysis 2 Time Overview

Selected displays:

0

Spectrogram

Remove

| oK | l Cancel l

3359001

Preset: Spectrum Analysi .‘.—.

Moise Figure
Time-Frequency Analysis

Preset displays: Spectrum Analysis |
. H odulation Analyss |

Jﬁ _L Pulse Analysis
Spur Search Multi Zone 9k-1GHz
Phase Noise
Spectrum

To go directly to a preset in the future, use Tools->0ptions-=Presets->Preset action

oK ] ’ Cancel

3224015
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4. The default displays for the selected
preset are shown.

5. Click OK to close the dialog box. The
preset displays will open. (See Table 2.)

Table 2: Application presets

Presets

m Application Presets @

Preset: [Moduation Anaysis X

T

Constellation  Signal Quality ~ Symbol Table DPX

®

Preset displays:

To go directly to a preset in the future, use Tools->Options->Presets->Preset action

@ © ok | [ cancel

3224004

Displays

Time-Frequency Analysis

Frequency vs Time, Spectrogram, Spectrum, Time Overview

Spectrum Analysis

Spectrum

Modulation Analysis (Option 21 only)

Constellation, DPX Spectrum, Signal Quality, Symbol Table

Pulse Analysis (Option 20 only)

DPX Spectrum, Pulse Table, Pulse Trace, Time Overview

Spur Search Multi Zone 9k-1GHz

Spurious

Noise Figure (Option 14 only)

Gain, Noise Figure, Noise Table

Phase Noise

Phase Noise
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Use a Standards Preset. When you select a specific standard from the Standards presets, the analyzer automatically
loads the displays and settings that are optimal for analysis of signals based on that standard.

1. Select Presets > Standards from the Presets | Tools  Windo @

main menu bar. Main

DPX
Standards
Application

User

Preset Options

3224019

2. Use the Preset pull down list to display

and select a preset from the list. TeEE — = @
3. The default displays for the selected N P25 ‘

preset are shown. M B E
4. Click OK to close the dialog box. The _ _

preset displays will open. (See Table 3.) SEM - Time Overview e
NOTE. Some presets appear only if the
associated instrument option is installed. S

sandice

To go directly to a preset in the future, use Tools-=0ptions-=Presets-=Preset action

@ ) (o

3224020

Table 3: Standards presets

Presets Displays

WLAN (Option 25) SEM, Time Overview, WLAN Summary, WLAN Constellation
P25 (Option 26) MCPR, Time Overview, P25 Summary, P25 Constellation
Bluetooth® (Option 27) BT Eye Diagram, BT Frq Dev vs Time, BT Summary, BT CF

Offset and Drift, Spectrum, Time Overview

NOTE. Bluetooth displays vary depending on the selected Test
Setup.

LTE™ (Option 28) LTE Summary, LTE Constellation, Time Overview, Spectrum,
LTE ACLR, LTE Channel Spectrum, SEM

NOTE. LTE displays vary depending on the selected Test Setup.
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Quick Tips
m  Push the Displays button on the front panel to open the Select Displays dialog box.
®  To add a display, double-click the icon.
= To remove displays, do one of the following:
= Select a display icon in the Selected Displays list, and then click Remove.
= Double-click a display icon in the Selected Displays list.
= Click the Close button in the upper right hand corner of the selected display.

= You can mix displays from multiple application folders.

Common Information Messages

The following table lists some of the common information messages that might appear during normal operation.

Table 4: Common information messages

Message Explanation and recommended action

Acq BW too small for current setup The display needs a wider acquisition bandwidth than the current data record
contains. This can be due to any of the following reasons:

m A display other than the one you intended has been selected. The selected
display has requested a smaller acquisition bandwidth to achieve a better
accuracy or dynamic range for its particular measurement.

Select the display that contains the message. Click Run if the instrument
is not already acquiring data.

B Acquisitions are not running and the measurement now requests a wider
bandwidth than the last acquisition.

Click Run to perform a new acquisition with a wider bandwidth.

B The data is from a recalled file.

There is no way to increase the acquisition bandwidth for saved data. You
must adjust the measurement settings so that less bandwidth is required.

Need swept acq or larger Acq BW When any display requires a swept acquisition, the other displays are unable to
process the swept data. This is because the swept data is customized for the
selected display.

Select the display that you are interested in and the acquisition settings will
automatically change to meet the requirements of the selected display.
RBW increased to xx kHz The current Spectrum Length or Analysis Length is not long enough to allow
a narrower RBW filter.

If the Length control is set to Manual, try increasing it or setting it to Auto so
that the Analysis Length will increase to the required value.
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Changing Measurement Settings

The displays have settings that control how signals are acquired and processed. The settings that you can change depend
on the selected display.

To access the settings (in this case, for the Spectrum display):
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1. Click Settings to open the Settings 2 Fe

e View Markers Setup Presets Tools Window
control panel.

EQe Y8800 MIvS P
®

2. Adjust the controls as needed for your Spectrum Fred & Span W | Tracss | Scale | Frefs |
signal or test. For example, use the = e e s
Freq & Span tab to set frequency and St LESGH
span. Most of the control panels have Stop: 19425 G
tabs that provide easy access to other Stepsus 50000 Bt
related controls. (See page 36, Quick e
Tip.)

3. You can change the appearance of the o e —
display screen in the Prefs tab. Not all - " Trace legend Parameters readout | ==
of the following controls apply to every
display. Some displays have additional
controls not described here.

Graticule

= To turn on or off the graticule, select
the Show graticule check box.

®  To turn on or off the marker readout,
select the Show Marker readout in
graph check box.

= To turn on or off the trace legend,
select the Show trace legend check
box. The trace legend includes
information on the trace number,
detection, and function (such as
average) for each trace on screen.

B To turn on or off the parameter
readouts. select the Show
parameter readouts check box.
This reports the time to create and
display the sweep of the spectrum
analyzer. It includes the entire
sweep plus any retrace time. When
trace averaging is activated, the
sweep reports the time for individual
traces while collecting the averages,
and reports the time for the entire
averaged trace when averaging is
complete.
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Quick Tip

= [f you have multiple displays on the screen, click anywhere inside one of the other displays to change to the control
panel for that display.

®m You can adjust many of the parameters of your measurement by clicking on the readout in the display. For example,
in the spectrum display, dB/div, RBW, VBW, Span, and Center Frequency can all be accessed on the display without

bringing up the Settings panel.
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Presetting the Instrument

You can preset the instrument to restore the setups to their default values.

1. To start with the default instrument

settings, push the Preset button on the (oispiys ) ((Setungs )~ (Rumssiop)
front panel or select Preset from the
toolbar. @ roqure)  (_single )
Replay
@ Analysis

I

arke
G A ()
i PG Ol
BW Delete - Ready
Trigd

©
COINCY

=
]

.B@O
g

§
g
i

() (&) (o) (o) (=) T
() (o) (o) Cme)
@G
OO @ (e | 1)

Quick Tip

B Preset does not change any of the settings specified from the Setup > Configure In/Out control panel or from the Tools
menu, such as GPIB address, Save/Export preferences, or the Auto Alignment setting.
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Connecting a Signal

A

The analyzer has a single RF signal input located on the front panel. Make sure that you observe the input signal
requirements before connecting a signal to the input.

CAUTION. To prevent static damage to the instrument or to any instrument accessories, discharge to ground any
electrostatic charge that may be present on the center and outer conductors of cables, before attaching the cables to the
instrument inputs. Do not create an ESD (electrical static damage) antenna by leaving cables attached to the instrument with
the other ends of the cables open.

Required Signal Levels

The following table shows the input signal levels over which the analyzer can be used for measurements. The accuracy
is guaranteed at a signal amplitude and frequency (normalization point). Measurements can be made on signals within
the entire range of allowable inputs, but the accuracy of the measurement is affected by the frequency and amplitude of
the signal to be measured.

RF signal input range (CW or peak envelope power)

Characteristic Description
Maximum DC voltage 15 V (RF input)
Maximum safe input power +30 dBm (RF Input, RF ATT=10dB, Pre-amp Off)

+20 dBm (RF Input, RF ATT=10dB, Pre-amp On)

+50 Watts peak (RF Input, RF ATT=30dB, (<10 s, 1% Duty Cycle
repetitive Pulses))

Maximum measurable input power +30 dBm (RF Input, RF ATT Auto)

+10 Watts peak (RF Input, RF ATT Auto (<10 ps, 1% Duty Cycle
repetitive Pulses))

CAUTION. To prevent damage to the instrument, do not connect CW signals greater than 1 Watt (+30 dBm). The maximum
voltage rating is £5 V DC. The maximum pulse specifications are 50 W peak, <10 us pulse width, 0.001 duty cycle and
230 dB attenuation.

38
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To connect an RF signal:

= Connect the signal to the RF INPUT ( ]
connector on the front panel. ~ [SEE—C]
SSECH
NOTE. On RSA5115B and RSA51268 oo o 0
instruments, you can change the RF input D282 =
connector type by using a different Planar :;:@i %
Crown connector. e R
oOCcooo O O
< 5 o
| e |

Quick Tip

m  [f the source signal exceeds the specified maximum input rating, connect the source signal to an attenuator. Connect the
attenuator output to the RF Input connector.

Starting and Stopping Acquisitions

1. Click the Run button to start an 1
acquisition. o[- B[S
Window  Help .
B To select the Run mode, click the Reflev: 0.00 dBrm BB (@ Replay - | D) Run .

drop-list icon to the right of the Run

button.
=0 N=H =

m  Select Single or Continuous to set the
Run mode as necessary.

el

Preset! | @ Replay -
= Single
) Continuous

If the analyzer is in Continuous Run

mode, the Replay button is dimmed while e
acquisitions are active. If there are no

acquisitions active, the Replay button is Preset Replay

blue.
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2. Click the Stop button again to stop an
acquisition. If an analysis is in process, it : [o] e ]
will finish its sequence and then stop. Window Help -8 x
Reflew: 0.00 dBrn Preset Replay =) Stap -

Clzar

Quick Tip

m  Push the front panel Run button to start and stop acquisitions.

Run Control

The Run menu provides access to commands that control the acquisition and the measurement sequence. Refer to

the online help for information on all of the Run menu selections. Continuous is the default selection. When you select
Continuous, the instrument will continuously acquire data until you stop the acquisitions. Select Single Sequence to run a
single acquisition every time you click Run or push the Run button on the front panel.

40 RSA5100B Series Quick Start User Manual



Markers

Operation

Use markers to measure time, frequency, power and other results. Markers measure absolute values and can also measure

the difference between markers.

Using Markers to Measure Frequency and Power

The following procedure shows how to use markers in the Spectrum display to measure frequency and power. The example
assumes that all markers are turned off and that a signal is on the screen.

1. Click the Markers button located at the
bottom of the display to open the Marker
toolbar at the bottom of the Analysis
window.

Alternately, press the front panel Markers
Define button.

2. Select Add Marker from the drop down
list in the Marker Toolbar.

The first marker is designated the marker
reference (MR).

3. Position the marker on the screen using
the arrow buttons in the Marker toolbar.
The left and right arrows move the
marker to the next peak. The up and
down arrows move the marker to the
next higher or next lower peak.

The peak excursion preferences are set in
the Define Peaks menu tab.

You can also drag the marker to the desired
position using the touch screen or the mouse.

4. Read the frequency and power level from
the marker readout on the display.

Quick Tip

Define Markers Marker Properties | Define Peaks‘

8
Reference Delta Markers e
| Add | Marker:
Attach to:
| Delete | (in selected
display) —_—
| Al Off | Add Marker ‘ Readouts: {Della—v‘
Delete Marker i
Markers All markers off | To Center | | Peak | Table || x|

2838007

I File  View lay Markers Setup Presets Tools Window Help 8 x
] o 2 = 1%, | Frequency: 15000 GHz Reflev. 0.00 dBm Preset Repla Ostop -

v Tra:1  [V|Show +Peak Normal ‘Clear‘

© 0.00 dBm

o dB/div:
10.0 dB

o RBW:
1.00 MHz
VBW:

MR: -10.00 dBm
1.5 GHz

-100.00 dBm

‘ Autoscale © CF: 1.5000 GHz © Span: 165.0 MHz

Markers | Defne | v MR Frequency v|1.5GHz To Center | [ peak | (€] [#] [¢] [#] [ Table | [x]

Transfer warm-up period Real Tme  Free Run Ref: Int Atten: 15 dB

3224-005

B Marker controls are available directly from the front panel Marker buttons.
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Markers Display

m Reference Marker: This marker type is labeled MR in the graph. It makes absolute measurements and is also used for
calculating differences when Delta or Power readouts are enabled.

m Delta Markers: This marker type is labeled M1 to M4 in the graph. It is used to measure other points on the trace or the
difference between the Marker Reference and the Delta marker.

m  Power Markers: This marker type is labeled M1 to M4 in the graph. It function the same way as Delta Markers, except it
shows power density and integrated power density (dBm/Hz) instead of power level (dBm).

The following information tells you more about how markers function. For more detailed information about markers, see
the instrument Help.

= When you drag markers along a trace with either the touch screen or the mouse, the marker will seek the high points.
The marker stays within 20 trace points of the mouse position. If there are no peaks within the current range of trace
points, the marker finds the highest point.

®  When you attach the marker to the bitmap trace in the DPX spectrum display, the marker readout indicates the hit count
for pixels (maximum 65,536) along with frequency and power (see the following figure). You can position the marker
at any point in the graph.

= Markers attached to the DPX bitmap display the signal density in percent at the selected pixel, rather than the hit count.

z_ _Dirmon _ ¥ Show On

© 0.00 dBm —
- dB/div: 1.5004125 GHz

10.0 dB -7.50 dBm
o RBW:

1.00 MHz

3224-006

Quick Tips

®  |f markers are turned off, click Peak in the Marker toolbar or on the front panel to add the marker reference (MR) and to
position it on the maximum peak level on the trace in the selected display.

®  Click Table in the Marker toolbar to open a tabular display showing the marker information.
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Marker Toolbar

The Marker toolbar has several controls to work with markers. (See Table 5.) Some of these controls are similar to those
on the front panel.

Table 5: Marker toolbar

Description

Opens the Define Markers control panel. Use the control panel to add and remove markers and

Define
to set marker parameters.

Sets the Measurement Frequency of the instrument to the frequency of the selected marker. This

To Center
button is only present when the selected display has frequency on the horizontal axis.

Moves the marker to the maximum peak level on the trace. The maximum peak can be either the
highest or the lowest point in displays with both positive and negative values on their vertical axis
(such as Frequency Error or Phase).

Peak

Moves the selected marker to the next peak to the left of the current position.

Moves the selected marker to the next peak to the right of the current position.

Moves the selected marker to the next lower peak value. The peak value refers to the absolute
value of the peak amplitude. When repeatedly moving the marker, it can move in any direction
depending on the location of the next peak. If the marker is attached to the DPX bitmap trace, this
button moves it to the next-lower-amplitude density peak at the same frequency.

Moves the selected marker to the next higher peak value. The peak value refers to the absolute
value of the peak amplitude. When repeatedly moving the marker, it can move in any direction
depending on the location of the next peak. If the marker is attached to the DPX bitmap trace, this
button moves it to the next-higher-amplitude density peak at the same frequency.

Table Opens or closes the marker table in the display.

I B |®|E III_

Adding Markers

You can have up to five markers. The first marker (MR) is a reference marker. The other markers (M1, M2, M3, and M4) can
show absolute values or can show both absolute values and the difference values between them and the reference marker.

To add another marker, select Add Marker from the drop-down list in the toolbar or from the front panel button.

Markers can also be added by right-clicking in the desired display and selecting Add marker.
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Defining Markers

Use the Define Markers control panel to define the marker settings.

1. Click Define to open the Define Markers wakers [Defe] « MR [Freauengy 190010835 Gr [« ] [

control panel. 200
Alternately, press the front panel Markers @
Define button.
Use the control panel to: Define Markers | Merker Properties | pefing Peaka)]
Reference Delta Markers

B Add or delete markers. add e "

Attach to:
®  Turn markers off. D

Readouts: [F] dBc/Hz

- . o
Assign markers to specific traces. e o [ BEE

m  Set the marker readouts to absolute or
delta.

m Define the threshold and excursion
values.

Quick Tip

B You can add or delete markers using the drop-down list next to Define in the Marker toolbar, or by right-clicking in the
desired display and selecting Add marker.

Touchscreen Actions

You can use the touchscreen to change marker settings and how waveforms are displayed by using the Touchscreen Actions
menu. To use the Touchscreen Actions menu, touch the display and hold for one second, then remove your finger. You can
also use a mouse to display the Touchscreen Action menu by clicking the right mouse button.

Some selections in the Touchscreen Actions IE P
menu are selectable only when a marker is
. [ Span Zoom
defined.
+* CFPan
©\ Zoom
{:‘"j Pan
Reset scale

Marker to peak
Mext peak 3

Add marker
Delete marker

All markers off

Trigger On This

Touchscreen Actions menu
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Table 6: Touchscreen actions menu

Icon

Menu item

Description

Select

Selects markers and adjusts their position.

Span Zoom

Zooms the graph area about the selected point. Touch the graph display at a point
of interest and drag to increase or decrease the span about the point of interest.
Span Zoom adjusts the span control and can affect the acquisition bandwidth.

CF Pan

Adjusts the Center Frequency according to horizontal movement.

Zoom

Adjusts horizontal and vertical scale of the graph. The first direction with
enough movement becomes the primary scale of adjustment. Adjustment in the
secondary direction does not occur until a threshold of 30 pixels of movement is
crossed.

Dragging to the left or down zooms out and displays a smaller waveform
(increases the scale value). Dragging to the right or up zooms in and displays a
larger waveform (decreases the scale value).

Pan

Adjusts horizontal and vertical position of the waveform. The first direction with
enough movement becomes the primary direction of movement. Movement in
the secondary direction does not occur until a threshold of 30 pixels of movement
is crossed.

Reset Scale

Returns the horizontal and vertical scale and position settings to their default
values.

Marker to peak

Moves the selected marker to the highest peak. If no marker is turned on, this
control automatically adds a marker.

Next Peak

Moves the selected marker to the next peak. Choices are Next left, Next right,
Next lower (absolute), and Next higher (absolute).

Add marker

Defines a new marker located at the horizontal center of the graph.

Delete marker

Removes the last added marker.

All markers off

Removes all markers.

Trigger On This

Positions the DPX Density measurement box at the click point, measures the
current signal density, sets up the DPX Density Trigger function based on the
measurement result, and starts acquisitions.
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Printing

You can print a copy of the screen and its contents (a screen shot) to a printer or a file.

1. Push the Print button on the front panel
or select Print from the File menu.

2. Fill out the details in the Print dialog box,
and then click OK.

The Print dialog box is the standard
Microsoft Windows Print dialog box. The
printer controls are dependent on your
printer.

46

View Markers Setup

= Recal... Ctr+0
H save CtrH+S
Save As...

Save on trigger...
Acquisition save options
FastSave acquisitions
Acquisition data info

Measurement data info

Print CTRL+P
Print Preview...
Exit
Print @
Printer
Mame: Adobe PDF '] [ Fropetties.. I
Status: Feady
Type: Adobe PDF Converter
Where:  Documentsh”.pdf
Comment: [ Print ta file
Print range Copies
@ Al Mumber of copies: 1 $
Pages
3 3 Collate
(71 Selection 1'2' 1'2'
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Ink Saver Mode

You can print screen images with a white background.

1. Select Options from the Tools menu. Window Heb
= Mask Search
Alignment
Diagnostics
Install Upgrades...
Licenses r
|~ Options |
@ signal Database...
£ RSAMap

2. Select the Prefs tab in the control panel. v Tl  @sow +PedkNomal

< 0,00 dBm

3. Set the Color Scheme to Blizzard. C/ETE

10,0 d&
The background color changes from " soonse
black to white in the graphs.

-100.00 dém

© CF: 1.0000 GHz © Span: £5.0 MHz

Options | Presats | Analysis Time | Save and Export | GPIB | Security | Pref

Calor scherme: | Blizzard =

[7] Markers snap to peaks when dragged
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Saving Data

You can save different types of data for future use.

48

open the Save As dialog box.

1. Select Save As. from the File menu to File | View Run Replay Mar
Recall... Ctrl+0
IE] Save Ctrl+5

Save As... @

Save on trigger...
Acquisition save options

FastSave acquisitions...

¥  Acquisition data info

Measurement data info

& Print... Ctrl+P
Print Preview
Exit
3224011
2. Navigate to the folder where you want [Tl sove e
to save the setups, or use the default @ij\ <« OSDisk (C:) » RSAS100B Files » Sample Data Records ~ [ 4 ||[ Search Sample Data Records P |
location. Organize v Newfolder =+ @
} [# Documents and Settings & Name '@ Date modified Type
3. Enter a file name. pelog: o) - ir
i ':"’g"m ::“ o || ACPRDemottiq 1 TIQ File
4. Select the type of file to save. (See i e L] FMDemotiq 1 TIQ File
[] | FreqHopDemo.tiq 1 TIQ File
Table 7) 84 Recovery [ IPR for 100 MHz LFM chirp at 1GHz CF10... 1 TIQ File
5. Click S Rs::wu:s :_'IES [} PulsgDemodiq 1/9/2013 TIQFil
. IC ave. i O tig TIQ File
File name: | v
Save as type: [ Acq data with setup (TIQ) (*tiq) -
4 Hide Folders Save

Table 7: File types for save

File types

3224010

Description

Setup files

Saves all of the setup information for all settings displays, except those settings that
are specified under the Tools menu (Alignments and Options) or in the Config In/Out
control panel.

Results Export files

Saves the trace and numeric data for the selected display. The trace and numeric data
are saved in CSV format as text files.

Picture (PNG/JPG/BMP)

Saves a graphical representation of the screen in the specified format. This option is
useful for including the graphic in reports or other applications. Marker readouts and
other information are included.

Selected Trace

Saves a trace for later recall back into the display from which it was saved.
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Table 7: File types for save (cont.)

File types Description

Acq Data (acquisition data Saves data for reanalysis by the analyzer (.TIQ) or as CSV (comma-separated value) or
and acquisition data export) MAT (Matlab) format to use with external software.

Measurement Saves a list of settings relevant to the selected measurement to a TXT (text file).
Quick Tips

m  Select File > Save or press the Save button to save the information to a file using the same name, path, and data type
as the last time that you saved. If the file already exists, the file name suffix number will increment if you previously
selected that option in the Tools > Options > Auto Filename control panel tab.

B Select File > Save As to open the standard Windows Save dialog box where you can edit the file name, choose what
data type to save, and select a folder for storing the file.
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Recalling Data

You can recall and reanalyze acquisition data and setup files previously saved by an RSA6100 Series, RSA5100 Series, or
SPECMON Series analyzer.

50

1.

2.

Push the Recall button on the front panel
or select Recall from the File menu.

In the Open dialog box, browse to the
location of the file.

If you do not see the file, select the type
of file from the drop-down list.

Double click the file name to load the file.

Quick Tip

If you recall a trace that has an x-axis range that does not fall within the x-axis range of the current graph, the trace will not be
visible. A small arrow will point off-screen in the direction of the recalled trace. Use the Frequency and Span (or Span and
Offset) controls to bring the trace on the screen in the Spectrum display. In other displays, use Horizontal Scale and Offset
(which can also be used in the Spectrum display). These controls are on the Settings > Scale tab.

File | View Run FReplay Mar

Recall.. Ctrl+0 o1 @

IEJ Save Ctrl+5

Save As...

Save on trigger...
Acquisition save options

FastSave acquisitions...

¥  Acquisition data info

Measurement data info

& Print... Ctrl+P

Print Preview

Exit

3224-009

(2)

[ open
@uv‘ <« 0SDisk (C:) » RSA5100B Files » Sample Data Records - | +3 ‘ ‘ Search Sample Data Records pel |
Organize v New folder =~ [ ®
PerfLogs 4 Name : Date modified

Program Files )
| 256 QAM EQ.tiq '9/2013 2:58 P|
Program Files (x36) )
ProgramData L ACPRDema.tiq ‘
RE:;VE || FMDemo.tiq )
a RSASIO;YB Files L] FreqHopDemo.tiq
Ex e Fil (| || IPR for 100 MHz LFM chirp at 1GHz CF 10...
ample Files
| PulseDemo.ti
Sample Data Records ‘q
User Presets L] QPSKDemodiq
: || TimeFrequency.tiq
emp
Users
Windows S o
File name: v | Acq data with setup (TIQ) (“tic v

3224007
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Advanced Techniques

This section contains advanced operating techniques. For examples of practical applications, see the RSA5100B Series
Real-Time Signal Analyzers Application Examples Manual.

Setting Up Triggering

The analyzers offer real-time power-level triggers, frequency mask trigger, frequency edge trigger, line trigger, runt trigger,
DPX density, and external triggers. It uses a trigger event as a reference point in time for the seamless acquisition of the
signal. This allows the analyzer to store both pretrigger and posttrigger information.

To set up triggering, first select the Event (source and trigger type). Next, continue to set other optional trigger settings,
such as Time Qualified aspects and define specific actions to be taken upon recognition of a trigger event (such as Save
data, save picture, etc ).

The analyzer has two triggering modes:

Free Run mode. In Free run mode, the instrument initiates acquisitions without considering any trigger conditions. It
is a fast and easy way to see the signals. Free Run is usually adequate for the Spectrum display unless you need to
specify a particular time at which to collect the data record.

Triggered mode. In Triggered mode, the instrument initiates an acquisition when a trigger event is recognized. The
conditions that define a trigger event depend on the selected trigger source. There are several source selections available for
choosing the signal to monitor for a trigger event.

Once you select the Triggered mode, you must select the source. The trigger sources are:
®  RF Input

B Trig In

B Trig2ln

B Gated

m Line

Once you select the trigger source, you can set additional parameters to specify the trigger event. If you specify the RF Input
as the trigger source, you can chose from the following trigger types:

Power Triggering. Power triggering triggers the instrument on time-domain signal characteristics. The incoming signal is
compared to a user-selected level in dBm. You can select the time-domain bandwidth and trigger on the rising or falling edge.

Frequency Edge Triggering. Frequency Edge triggering triggers the instrument on time-domain signal characteristics.
The incoming signal is compared to a user-selected level in Hertz. Frequency edge trigger is similar to Power triggering,
except you also need to set a power threshold to avoid triggering on the apparent frequency fluctuations that occur at low
amplitude. You can select the time-domain bandwidth and trigger on the rising or falling edge.

Frequency Mask Triggering. Frequency Mask Triggering allows you to trigger the instrument when a signal in the
frequency domain violates the mask. You can draw a mask to define the conditions within the real-time bandwidth that will
generate the trigger event. It allows you to trigger on weak signals in the presence of strong signals. This triggering is
also useful for capturing intermittent signals.

DPX Density Triggering. This trigger type enables the instrument to capture any signal you can see in the DPX display,
including difficult to see signals hiding beneath other signals that have a higher amplitude or a greater repetition rate. Using
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the Trigger On This™ feature, you can draw a box around the area of interest in the graph, set a Density threshold, and
the instrument will trigger when the measured Density exceeds your threshold.

Runt Triggering. Runt triggering defines a trigger event based on a pulse amplitude that crosses one threshold but fails
to cross a second threshold before recrossing the first.

In addition to defining the trigger event, you can define the following parameters by selecting the Advanced tab in the
Trigger control panel:

B Position and Delay parameters that define where a trigger occurs within the acquired data record and whether to
delay the trigger for a set amount of time.

®  Whether a single event can trigger an entire sweep, or each segment of the sweep requires a new trigger event in
swept acquisition mode.

Time Qualified Triggering. Time Qualified triggers allow you to trigger the instrument based on when signal transitions
occur in time. You can apply time qualification to the basic trigger types. For example, if you select the Power type and
configure it to trigger on a rising edge, Time Qualification allows you to screen rising-edge events based on how long the
signal stays high after it exceeds the trigger threshold. You may wish to trigger only on pulses that last longer than a
specified time or shorter than a specified time. You can set Time Qualified to accept only pulse widths between two specified
values, or outside of these two values.

You can time qualify Frequency Edge, Frequency Mask, DPX Density, and Runt trigger events. For each trigger type,
the instrument finds all events that meet the basic trigger criteria, then further tests them against your time qualification
parameters.
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Accessing Trigger Parameters

1. Click Trig to open the Trigger control
panel.

Alternately, press the front panel TRIGGER
button.

2. As shown in the following steps, click
one of the tabs in the Trigger control
panel to define the trigger parameters.

3. Use the Event tab to set parameters that
define trigger events. The parameters
vary depending on the trigger Source
and Type selections.

4. Use the Time Qualified tab to set
parameters that qualify trigger events
based on their time duration.

5. Use the Advanced tab to set parameters
for trigger position and holdoff settings.

6. Use the Actions tab to set parameters for
the Save on trigger function. The Save
on trigger function allows you to save
an acquisition data file and/or a screen
capture when a trigger event occurs.
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Quick Tip
m  Other ways to access the Trigger control panel;
= Push the Trigger button on the front panel.

= Select Trigger. from the Setup menu.

Setting Up a DPX Density Trigger

The DPX Density trigger enables you to capture transient events that may be partially obscured by other higher-amplitude
or more frequent signals. If you can see it in the DPX bitmap, you can trigger on it. The DPX Density area measurement
is used to select the region of interest in the display and to measure its current density. You set a density threshold, and
the instrument triggers when the density measurement exceeds your threshold.

The quickest way to set up a DPX Density trigger is to use a mouse and right-click on a signal of interest in the DPX
graph, or press on the screen and hold with your finger for one second. A menu will pop up. Select Trigger On This.
This action performs several tasks:

B Places the density measurement box at the click point

®  Sets the measurement box to its default size

B Measures the average density in the box

B Sets the Trigger mode to Triggered

B Selects the DPX Density "Higher" trigger type

®  Adjusts the trigger threshold to a density value slightly below the current measured value
B Starts the acquisition process

To optimize DPX Density trigger settings for your particular signals, open the Trigger control panel. Use the controls for
changing the polarity of the trigger's threshold comparison (Higher versus Lower), the Threshold value, and the size and
location of the measurement box. Use the Frequency and Amplitude settings to locate the center of the box, and set the +/-
values to adjust the width and height of the measurement box.

For events that are partially masked by stronger signals, you will often need to adjust the density Threshold based on
density measurements of the event of interest and of the obscuring signal. For example, if the density of the background
color representing only the stronger signal is 7% and the density measurement including both signals is 9%, you would
set the Threshold to 8%.
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~  tmap  [@show On

© -20.00 dBm

Acg BW: 40.00 MHz, Acq Length: 8.660 us Real Time _ Free Run Ref: Int_Atten: 10 dB

If your expected signal is a continuous tone and you want to capture events when it hops to a different frequency or drops
to a lower amplitude, move the Density measurement box to surround the peak of the signal, select Lower in the Density
control, and set Threshold to 100%. The instrument will trigger when the signal is absent from the measurement box.

Hint. The density measurement is the average of the densities for each column of pixels in the box. If your measurement
box is wider than the peak of a CW signal, the density reading will be less than 100%. To get a 100% reading, you can
broaden the peak by increasing RBW or narrow the box until there are no colored pixels either above or below the box. The
signal should enter the left side of the box and exit the right side. It should not cross the bottom edge of the box.
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Creating a Frequency Mask

Use the Mask Editor to create a Frequency Mask. The mask is a set of points defined by frequency and amplitude. Access
the Mask Editor from the Trigger control panel. (This procedure uses the Spectrum display.)

You can create a Frequency Mask by using either the manual or Auto Draw method. The following procedure explains the

manual method. For a procedure on how to use the Auto Draw method, see the topic Mask Editor (Frequency Mask

Trigger) in the online help.

1.

o B~ b

Click Trig to open the Trigger control
panel.

Select the Event tab in the control panel.
Set the Source to RF Input.
Set the Type to Frequency Mask.

Click Mask Editor to open the Mask
Editor.

The Mask Editor opens with the traces of
the Spectrum display in the graph.

Click New in the tool bar. This removes
the existing mask and then creates a
default 6-point mask.

= File View Markers

Setup Presets

Tools

Window

EHe YS LSO MIVS P

@

1010

Trigger Event | & Tinle Qualifis s | Advanced | Actions

®

Winlation
Source:

——e—h | &7 ST5F
RF Irput 1)

IF O F:T

@ Free Run

Triggered
- Tngg Type

Force Trigger

O THFST

O F=T=F

Frequency Mask - @ True - False

Mask Editor
Load from file. ..

REWY: 500 &7 Auto

2838036

—Qur Maskl

File

=1 Be| =5

Save Save As.,

oo ] [om

\ Done

Reference: |Spectrum Trace 1 -

(to be in list, a trace must be showing in a display)

Clickin © Add paints
araph MNext X Undo
to: @ Edit Paoints

0,00 dBrn

ﬂ'l

"fﬂl ~

H‘lﬂ ”J i \TII 1

,m‘ \I “\”".ww'}w

-100.00 dem
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Y Margin: 10,000 dB

e

Auta draw
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Amplitude
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-10.00 dBm
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7. Click any point in the mask to select it.

The frequency and amplitude of the
selected point are highlighted in the
graph.

8. Edit the point by doing one of the
following:

= Drag and drop the point with the
mouse.

B Enter the frequency and amplitude in
the table.

= Adjust amplitude with the up/down
arrow keys and frequency with the
left/right arrow keys.

Quick Tips

at Mask Editor - Maskl

=8 | Bo =5

File

Reference: [Spectrum Trace 1 'I
(to be in list, a trace must be showing in a display)

I Mew H Open [ Save ’Saueﬂs... Done ‘

X Margin: 5.000 MHz

Y Margin: 10,000 dB

E Auto draw

Oftyet Freq Amplitude i

-17.000 MHz -30.00 dBm

-8.500 MHz -10.00 dém

0,00 dBrn

Clickin ~ © Add points
araph Next Undo
to: @ Edit Points

-10,00 dEm
-30.00 dBm
-30.00 dEm -

8,500 MHz

-100.00 dém 17.000 MHz

42,479 MHz

CF: 1,900 GHz

Span: 85.00 MHz

2838038

m  Click Auto draw to generate a mask automatically adjusted to the Reference. Set the X Margin (frequency) and Y

Margin (amplitude) before pressing Auto draw.

m  Right click on the display screen to add a new point.

m  Click Add Points and then click on the graph to add a new point in the graph.

m  Click Next to select the next point in the graph.

®  (Click the X (delete button) to delete the selected mask point.

m  Click Save to save the mask file and continue working with the mask editor.

®m  Click Open to load and edit a previously saved mask file.

Defining Trigger Conditions

After you have set up the mask, you can select whether to trigger on the presence or absence of mask violations.

1. Select a condition.

The choices are described in the
following table. (See Table 8.) The icons
at the bottom of the control panel identify
what is considered true or false.

2. Click Triggered.

The instrument will trigger when the
trigger conditions are met.
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Table 8: Trigger violations

Violation Description

T The instrument triggers whenever the signal violates the mask (above the line).

F The instrument triggers whenever the signal has no points in the mask.

T>F One transition defines the trigger event. The signal must go out of the mask (no violation)
after being inside of the mask (violation).

F>T One transition defines the trigger event. The signal must go into the mask after being

outside of the mask.

T>F>T Two transitions define the trigger event. The signal must start inside of the mask, cross
outside of the mask, and then cross back into the mask.

F>T>F Two transitions define the trigger event. The signal must start outside of the mask (no
violation), cross into the mask, and then cross back outside of the mask.

Controlling Acquisitions

When two or more displays are open, one display controls the acquisition system. The acquisition requirements for the
selected display set the acquisition hardware parameters. While the acquisition parameters are optimized for the selected
display, they might not be ideal for other displays. In this case, the other displays might be unable to maintain optimum
performance and consequently might be unable to produce results. (This also happens when you analyze recalled data:
measurements attempt to deliver results, but may not be able to comply with all their settings.)

You can specify which display controls the hardware acquisition parameters by clicking anywhere in that display. When there
are multiple displays, the highlighted display controls the hardware acquisition parameters.

In this example, there are two displays, a

Spectrum display and a DPX Spectrum
display. The highlighted title bar on the
Spectrum display indicates that it is the
selected display.

The check mark indicator in the upper
left corner of the display indicates that
acquisition hardware is optimized for the
Spectrum display.

[ File View Run Replay Markers Setup Presets Tools Window

Help

<] & & T & £ 1% | Frequency: 1.0000000 GHz  Reflev: 0.00 dBm Fresat Repla 2 Stop

[TV opx Spectrum =@

~ itmap  [¥Show On [ clear

© 0.00 dBm

i
e

-100.00 dBm

[Autoscale | = CF: 1.0000000 GHz © Span: 100.0 kHz

52 || [T spectrum

J v Tracel [@show
© 0.00 dBm

i fia
[\l "‘n\\h‘\_,‘
MR

[(Autoscale | = CF: 1.0000000 GHz © Span: 100.0 kHz

Transfer Acq BW: 156.25 kHz, Acg Length: 2.501 ms Real Time _ Free Run Ref: Int _Atten: 25 dB

Some displays do not control the acquisition hardware. These displays just show the captured data. Some displays share
the same parameters. If any of one of these displays in such a family controls the acquisition hardware, then the acquisition
parameters are optimized for all of the displays in that family.
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Measurements with Conflicting Acquisition Requirements

The analyzers let you open any combination of measurements. You can select the displays that you are interested in and the
instrument will automatically set up the appropriate analysis and acquisition parameters.

If measurements place conflicting requirements on the acquisition parameters, the current selected display takes priority. The
following example shows incompatible measurement settings when one display needs real-time data (such as the Amplitude
vs Time measurement) while another display requires swept data (such as a Spectrum graph with a very wide span).

1. Push the Preset button on the front
panel to set the instrument to the default
settings.

2. Tune the instrument to the frequency of
your signal and then set the span.

3. Click the Displays icon to open the Select
Displays dialog box.

4. Select the General Signal Viewing
folder.

5. Select the Amplitude vs Time icon.

6. Click Add to add the icon to the Selected
Displays list.

NOTE. Add the Spectrum display if it is not
already in the Selected Displays list.

7. Click OK to accept the changes and
close the dialog box.
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8.

10.

Increase the span in the Spectrum
display to 200 MHz.

Because Spectrum is the selected
display, the acquisition parameters
adjust automatically to meet the needs
of the display. The 200 MHz span
exceeds the real-time bandwidth of the
instrument. As a result, the instrument
will change to swept mode.

Look at the Status bar. The readout
“Swept” indicates when acquisitions are
swept.

When the acquisitions are in “Real Time,
all measurements usually run. If the
acquisitions are swept, only the selected
display can run.

»

Click the Amplitude vs Time display to
make it the active display.

The acquisition switches back to
real-time because the selected display
requires real-time. The data is now
suitable for the Amplitude vs Time
display but doesn't contain the full range
of frequencies needed by the Spectrum
display.

In this case, the Spectrum is unable to
run.
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11. Decrease the span to 25 MHz in the
Spectrum display. Now the acquisitions

are real time again.

12. Check the status bar readout to verify

that the acquisition is real-time.

Both of the displays can run now.
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Mask Testing

The analyzer lets you test many trace results for changes in level. You can identify matches crossing a power level or
you can create a mask that specifies power level and frequency range limits. You can select which trace to test and
specify an action to take when a test condition is met for traces in the Spectrum, DPX, Noise Figure, Spurious, and Setting
Time displays. The Frequency Settling Time, Phase Settling Time, Spurious, Bluetooth InBand Emission, and Occupied
Bandwidth measurements tests provide pass/fail results.

The available choices include only results from displays that are currently open.

Selecting Mask Test from the Tools menu displays the Mask Test control panel. These settings define test parameters and
specify actions to be performed when the test conditions are met.

To start a mask test. Perform the following steps to set up for any mask test.

1. Open the Spectrum display or select the Took | Wind Hel
Spectrum display if it is already open. et |
Mask Search

Alignment

2. Select Tools > Mask Test.

Diagnostics

Install Upgrades...

Licenses »
Options
= Signal Database...
& RSAMap
3. Select the Enable Test check box to set Mask Test | Dafne | Actions]
the application to perform the test once
the conditions are defined. Enable Search in:
Test for: IE outside mask v] [ Edit limits... ] [Load from file...
4. Select the trace you wish to test from the @
Search in drop-down list box. B e [acsand
E':;_EIE Search in: |Spectrum: Trace 1 v]

Spectrum: Trace 1

Spectrum: Trace 2

Spectrum: Trace 3

Spectrum: Math Trace
Spectrum: Spectrogram Trace

Test for:

‘ -20.00 dBm

3e24-024
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5. Verify that the trace you selected in the
Search in list is the selected trace and
that the Show box is checked.

6. Click the Actions tab to specify what
actions the analyzer should take when a
match occurs.

The analyzer can take up to five actions
when a match occurs, depending on the
run mode. In Run mode, the analyzer
can sound a beep, stop acquisitions,
save acquisition data, save trace data,
and save a picture of the display. In
Replay mode, it can sound a beep and
stop analyzing.

7. To have the analyzer take an action
when a match occurs, select the desired
action.

You can select any combination of
actions to perform on a match. If you
select all actions, they will all occur when
a match is found (in Run mode).
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[S] ® & T = % 18| Frequency: 14535 GHz
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®

V|Show +Peak Normal

Trace 1
0.0 -

Clear

-40.0 - B

Data from uncalibrated instrument

CF: 1.50000 GHz © Span: 10.00 MHz

324023

Window  Help 8 x
) Stop -

Replay  Matkers  Setup  Toals

Reflev: 0.00 dEm Preset Replay

<
© 0,00 dBrn
o dBjdiv:
10.0 d&
o REW!
2100 Mz
VBW!

-100.00 dBm

| Autoscale |

Search

Enable
Search

w  Trace 1 []Show +Peak Mormal ‘Clear ‘

© Span: 100.0 MHz

@ CF 14535 GHz
Define | Actions
8

During Run o Replay During Run only

Beep
Stop

Save acquisition data ‘ TIQ -

Save trace

Save picture ‘ PNG ~

324006

@
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To perform a Greater Than/ Less Than mask test.

1. Specify what to test for by making a

selection from the Test for drop-down Mask Test
list.
To test for signal levels above or below 7 fe
a specified level, select either is greater
than or is less than.

Transfer

2. Press the Run button to initiate a test.
Click the Replay button on the toolbar to
initiate a test on the current data record.

» dB/dv:
10.0 dB
o RBW:

3. Notice the vertical red bar. It highlights et
results that match the test definition. e

4. Click the close box to remove the Mask
Test control panel.

Define | Actions

®

Search in: ‘Spectrum: Trace 1 '|

Test for: |is greater than

is greater than
is less than

is outside mask
is inside mask

- -20.00 dBm

Not calibrated

v Trecel /| Show +Peak Normal

Data from uncalibrated instrument

Autoscale | © CF: 1.50000 GHz

Ref: Int Atten: 30 dt
32425

weal Time  Free Run

®

Clear

© Span: 10.00 MHz
324027
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To perform an Outside/Inside mask test. If you specify a mask-based test, then you need to edit the mask to specify
the levels that define a violation. You can do this as follows.

1. Select is outside mask or is inside mask from the Test for menu.

2. Click the Edit limits button to display the Mask Test Editor window.

Ll Mask Test Editor - Mask] * b S S o S -

File

Reference: |Spectrurn Trace 1
(to be in list, a trace must be showing in a disg

Click in Add points X Margin: 0.000 Hz
graph Next X Undo
to: @ Edit Points ¥ Margin: 20.000 dBm

‘ Mew H Open H Save ‘

Save As... ‘ ‘ Done ‘

0.00 dBm —
Enable I

| Upper Mask
Upper Mask Table - V| Lower Mask |

Offset Freq Amplitude
I |
ﬂﬂ‘” |‘|u

1
| .
-100.00 dBm I
Offset:  1.50000 GHz Scale:  40.00 MHz (l

3. Click the New button to create a table. This clears the existing points and loads the default table. You can also click
Open to open an existing table.

4. To edit values, add points, or delete points in a table:

a. To edit an existing value, double-click on the cell you want to edit and enter the desired value. The active point
shows as a red point on the plot.

Reference: |Spectrum T = =
‘ New ‘ ‘ Open ‘ ‘ Save ‘ Save As... ‘ ‘ Done ‘ | pectium Trace |
(to be in list, a trace must be showing in a display)
Click in Add points X Margin: 5.000 MHz
araph ‘ MNext ‘ ‘ X ‘ ‘ Undo )
to: @ Edit Points ¥ Margin: 10.000 dBm

BED T u - u Auto draw
u Enable
V| Upper Mask
Upper Mask Table - Lower Mask
Offset Freq Amplitude o
-16.000 MHz -5.00 dBm
-5.00 dBm
8.000 MHz -5.00 dBm E
-100.00 dBm 16.000 MHz -5.00 dBm
Offset: 0 Hz Scale:  40.00 MHz 20.000 MHz -10.0 dBm s
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b. To add a new point, check the box next to the target mask (located below the Auto draw button).
c. Select Add points located below the Open button.
d. Select the target mask (Upper Mask Table or Lower Mask Table) from the drop-down menu.

e. Click in the desired location on the plot to add the point.

Reference: -
‘ Hew ‘ ‘ Open ‘ ‘ Save ‘ Save As... ‘ ‘ Done ‘ |Spectrum dlcag |
(to be in list, a trace must be showing in a display)
Click in @ Add points . X Margin: 5.000 MHz
graph MNext X Undo
to: Edit Points ‘ ‘ ‘ ‘ ‘ * ¥ Margin: 10.000 dBm
0.00 dBm \ﬂ — \i‘ Auto draw
u Enable

¥| Upper Mask

Upper Mask Table - Lower Mask

Offset Freq Amplitude i
-3.508 MHz -5.36 dBm
iros e | 2sam |
8.000 MHz -5.00 dBm |
e 16.000 MHz -5.00 dBm [
Offset: 0 Hz Scale:  40.00 MHz 20.000 MHz -10.0 dBm -

f.  To use the auto draw feature to automatically place points on the chosen mask, enable the desired mask from the
drop-down menu and then click the Auto draw button.

Reference: |Spect[um Trace 1 v|
(to be in list, 3 trace must be showing in a display)

Clickin @ Add points 1 [ ] X Margin: 5.000 MHz
araph Next X Undo
to: Edit Points Y Margin: 10.000 dBm

‘ New H Open H Save ‘

Save As... ‘ ‘ Done ‘

Enable
Upper Mask
Upper Mask Table ~ V| Lower Mask
Offset Freq Amplitude i
15.350 MHz 20.1 dBm
15.400 MHz 20.4 dBm
19.700 MHz 19.0 dBm
-100.00 dBm 19.750 MHz 21.4 dBm
Offset: 0 Hz Scale:  40.00 MHz 20.000 MHz 21.4 dBm i

NOTE. Units may be changed for measurements other than Noise Figure in Setup > Analysis > Units.

5. To delete a point from the table, select the point to be removed, and click the X button.
6. To save the mask to a file for later recall, click Save As.

7. From the Save As dialog, name the file and save it in the desired location.
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NOTE. Masks are saved in XML format with a .msk extension.

8. To dismiss the Mask Test Editor window, click Done.

Mask Test result examples. The following figure shows the results of a Spectrum is outside mask test with Upper Mask
enabled. The vertical red bar highlights results that have exceeded the test limits. The shaded region shows the mask area.

¥ Trace 1 /| Show +Peak Normal Clear
= 0Bfdiv: 0.0 -
10.0 dB
= RBW:
100 kiHz
VBW: 2 =
-40.0
-60.0 -
P
!
800 - | [ A
[y
"Il “ |
Data from uncalibrated instrument
-100.0 -
Autoscale @ CF: 1.50000 GHz = Span: 10.00 MHz

The following figure shows the results of a passing Noise Figure is outside mask test with Upper Mask enabled. Markers
are also in use.

< ¥ Tacel [¥Show Normal Clear
2 30048y oyggap 141:2.28 dB
o Jdv 26GHz 2875 GHz
L1 575,61 md8
200 mdB8 875 MHz

M1

N

o Posttion:
2.00 d8

v L00d8
Autoscale @ Pos: 2.5000 GHz o Scale: 1.0 GHz
Max: 23d8 @ 2.958GHz Min: L5d8 @ 2.083GHz Mean: 2.0dB

Makers | Define | w MR [Frequency ~|26Hz To center | [Peak | [«] [] [*] [#] [Table =
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The following figure shows the results of a failing Noise Figure is outside mask test with Lower Mask and Upper Mask
enabled. The red area highlights the area of failure, which occurs at the lower mask. Markers are also in use.

s ¥ Tacel [ZIshow Homal
v 2938 ygoyssas
» Jdiv 2GHz
1.00d8
R
o Position:
24.3d8
v 19.3d8
© Pos: 2.5000 GHz & Scale: 1.0 GHz
Max: 27.508 @ 2.000GHz Min: 21.1dB @ 3.000GHz Mean: 25.9dB
Markers [ Define ] w M1 Frequency ~|875 MHz

To cereer| [peae) [€) ) &) [®) [T (]
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Using Correction Tables

The analyzers let you correct the signal displays and measurement results to account for gains and losses in external
equipment. You can specify a single gain value or you can use an external loss table to adjust the gain/loss value based

on frequency.

To specify external gain/loss corrections:

1. Press the Amplitude icon button to
display the Amplitude control panel.
[l File vView Run Replay |Markers Setup Presets Tools Window Help 5 x
2. Select the External Gain/Loss B S $ @ T = 218 Feqenc: Lam0eH:  Reflew: 000 dém O @ ey - [Dwp -
COrrection tab v Trare1 [YIShow +Peak Normal ‘C\EE
© 0.00 dem
o dBfdiv:
10.0 dB
o RBW:
200 joiz
WEW:
-100.00 dBm
| Autoscale | = CF: 1.90000 GHe © Span: 25.00 MHz
Amplitude Internal Settings | External Gain/Loss Correction | External Probe Correction “
External Loss Tables (Loss = 0, Gain < 0)
External Gain value: 0.0 dB
Ext Loss Table 1 | Edit.. |
Apply external corrections to:
All acquired data (filter mathod) Ext Loss Table 2 | Edit... ‘
o P e R Ext Loss Table 3 [Edr..
2838047
3. To apply a constant correction factor,
select the External Gain value check
box. Enter a value into the text entry box. arplitude Intern|| Settings | External GainjLoss Corection | Extemal Frobe Correction
NOTE. You can enter either positive or 7] Extermd Gan vdus: 0.0 0B Extemal Loss Tabes (Loss > 0, Gan < 0)
X . o Ext Loss Table 1 | Edt.. |
negative gain values. Positive values Apply external comections to; — =
i A . it Loss Table Edit...
represent a gain. Negative values represent e ats e et
a IOSS (see Lser r\?apnua\ fior Iis’i) i Ext Loss Table 3 \L‘
2833042
4. To use a table that corrects for gain/loss
values depending on frequency, click a
check box under External Loss Tables. Amplitude [ mternal Settlﬂgs‘ External GainfLoss Correction | Extern:| Probe Correction |
You can enable all three external loss o B et o0 & Extemal Loss Tables (Loss > 0, Gn < 0)
tableg at the same time. Thus, you could ol externd conections 1o [ ExtLoss Table 1 (L. ]
use different external loss tables for an all acquired ciata (fiter method) O [Ext Loss Table 2 [ Edt. |
antenna, a preamplifier, and for cabling. o s | [Ext Loss Table'3 =T
2833043

5. To edit the contents of an external loss
table, click the Edit button for the table
you want to edit.
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6. Edit the contents of the table to match A e o T =
the loss characteristics of the equipment
you are correcting for. Click OK when | agront | | ookte Urelo : Frequency ¥: Loss (Atten)
you are fInIShed 914.0000 MHz -2.000000 dg

NOTE. You can enter either positive or ey (G Ee . y

negative values into the table. But in contrast ® Linear 526,000 M -2.000000 ¢

to the External Gain value setting, positive Log (sfects criy

Trace Carrection)

values represent a loss and negative values
represent a gain.

For detailed information on using the Table

Editor, select Help > User Manual and look S——— ‘ - ‘ e ‘ | = | ‘ = ‘ ‘ Corel ‘

in the Index for External Loss Tables.

7. YOU can Change the tlﬂe fOF eaCh eXtema| [T File View Run Replay Markers Setup Presets Tools Window Help & x
loss table. Select the title box and type BIS S8 T Y] ropency Lo che | Rl 000 o |8 ey o D5
in a new title — v Trace1l  [YIShow +Peak Normal [ clear |
Note that the title is only a label. It is oL
not tied to the file name of any table you o
have loaded or saved. vEn:

8. Specify whether table corrections are
applied to all acquired data or only to -

. -100.00 dBrm -
traces in the Spectrum, Spectrogram, | O AETES T E
SpUriOUS and Amplltude vs Time amplitude Intemal Ssttings | Extetnal GainLoss Comection | Extemal Probe Carrection ’|
d|sp|ays EEEme [T Extemal Loss Tables {Loss » 0, Gain < 0} I

i . = [@  Antenna Edit
Corrections applied to data are pply extemal cortections to: . -

i i H Al acouired data (fiter metho reamp it....

performed in real time using the digital ) -
" ey . . @ Cabilirg Edit...
filter capabilities of the instrument. While R E e ¢

this has the advantage of correcting —
the data for use in all measurements, @
digital filtering is limited in its ability to

apply corrections that change rapidly in

amplitude over small frequency ranges,

as may occur when switching between

two antennas. When this happens,

the filters may result in an amplitude

correction that appears to ring in its

response, resulting in poorly corrected

data. For that reason, the RSA offers

trace-only correction for spectrograms,

spectrum, spurious, and amplitude vs.

time displays. These trace corrections

are similar to those applied in traditional

spectrum analyzers, and should be

used when discontinuities occur in the

amplitude/frequency correction table.
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When choosing whether to correct
sample data or traces, keep the following
in mind:

B |f sample data is acquired while
data correction is enabled, that data
record is permanently corrected. If the
acquisition is saved and recalled, the
recalled acquisition includes corrections.
Corrections are not saved separately
from the raw data; they are used during
the acquisition process to adjust the data
values.

®  Trace corrections can be applied
at any time, as they are part of the
measurement's computations. Using
Replay will apply trace corrections to
a trace if this control is enabled (and
an external loss table is specified and
enabled).

B Be aware that if you recall acquisition
data that was saved with data corrections
and you use Replay with trace
corrections selected and an external
loss table enabled, the trace will be
calculated using corrected data and also
corrected with trace corrections. This
usually creates incorrect traces.

9. Click the close box to remove the
Amplitude control panel when you are
finished making changes.
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Using Audio Demodulation

The analyzers can demodulate AM and FM signals, which can help you to analyze known and unknown radio signals. You

access the Audio Demod tab from the Settings control panel of the DPX Spectrum plot display.

To demodulate an audio signal:

1.

Click the Displays icon to display the
Select Displays dialog box.

Select the General Signal Viewing
folder.

Double-click the DPX Spectrum icon to
add it to the Selected Displays list.

Click OK to close the dialog box. The
DPX display will open.

If necessary, select the Spectrum plot
from the drop-down list.

Press the Settings front-panel button to
display the DPX Settings control panel.

Click the Audio Demod tab to display
the Audio Demod control panel.

@

®

Choose any|combination below, or use an Applicatipn Preset. Application Presets...

Available displays:

Measuremer|ts:

Analog Modulation
GP Digital Modulation
RF Measurements
OFDM Analysis

Audio Analysis
Bluetooth Analysis
P25 Analysis

Pulsed RF

WLAN Analysis

General Signal Viewing [N

AMPL
I

Amplitude vs
Time

AF 10
A

Time

Selected displays:

)
B

RFI&Q vs Spectrogram

FREG.
Mt

Frequency
vs Time

Time
Overview

Phase vs
Time

®

Add

Spectrum
Remove
oK Cancel
3359002
[[1 File View &4n Replay Markers Setup Presets  Tools Window Help 8 x
® (@[] T = % 17| Frequency: 488,20 MHz RefLewi 0.00 dBm Bt | @ Replay - |DFRun -
~  Bitmap  [VIshow Fle:DPX Pulsed Clear
© 0.00 dBm
« dBfdiv:
10048
o REW:
00 kA

Spectrum -
-100.00 dBm
© Pos: 488,28 MHz © Scale: 10.00 MHz

Plot:

Spectrurm -

Restore
Defaults

Audio

Gain™®
off
(]

El

AM

T

Autoscale
5 DPX Settings | Freq & Span| BW | Traces | Horiz & Vert Scale | Bitmap Scale | Prefs | Density | Audio Demod

Tune with: Maker MR+

Recelver Freg;  488.2 MHz

Receiver Byy; #0000 kHz

* Sound level is also affected by Windows volurne contral

32408
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8. Click the On button to enable audio
demodulation.

9. To specify the demodulation type, click
either the AM or FM button.

NOTE. Note that the AM and FM buttons
select only the demodulation type; they do
not specify a frequency band.

10. Set the center frequency as needed.

The receiver frequency (frequency to

be demodulated) is specified with either
markers or the frequency control (the
front panel Frequency button or the Freq
control in the toolbar). Use the Tune with
setting to specify whether markers or the
frequency control is used to specify the
receiver frequency.

11. Select either a marker or frequency
control from the Tune with drop-down
list.

12. If the marker you select is not enabled
(it will be visible in the display if it is
enabled), click the Markers button in the
toolbar to display the Markers toolbar.

RSA5100B Series Quick Start User Manual

DPY Settings

8

| Freq & Seln | Bw | Traces | Horie & vert Scale | Bitmap Scale | Prefs | Density | Audio Demod ‘

Tune with: |Selected Marker =

Llct I on AM
{Spectrum vI Audio Recetver Freq:  91.5 MHz
Gain™
Off FM B 30,000 kHz
Receiver BW: '
=

Restore
Defaults

* Sound lelvel is also affected by Windows volume control,

©

DPY Settings | Fren & Epanl B I Traces | Hariz & Wert Scalel Bitrnap Scale | Prefs | Density ‘ Audio Demad
Plot: Tune with: __Selected Marker =
. On AM Marker MR
[Epettrurn vJ Audio Norahuoy Bran: Wy w1
Gain™ - Marker M2
Off Fr " . Marker M3
o Receiver BW: Marker M4
Selected Marker
gg?‘;aﬁ * Sound level is also affected by Windows wiFreq control
[[1 File Viel: Run Replay Markers Setup Presets  Tools Window Help 8 x
B T % %% IR | Frequency 480.30MHz  Reflew 000 dBm Pt | @ Replay - |DRun -
~ gitmap  [VIShow Fie:DPX Puksed =
© 0,00 dBm
o cBfdi:
100dB
= RBW:
100 KHiz
Spectrum -
-100.00 dBm

Autoscale © Pos: 488,28 MHz

DP¥ Settings

Plot:

Spectrurm -

© Scale: 10.30 MHz

‘ Freq & Span I B | Traces I Horiz & Vert Scale I Bitmap Scale |Drefs |Densitv‘ Audio Dernod

Restore
Defaults

&

Tune with: Maker MR+
on
e Audi Receiver Freq: 483,275 MHz
Gain™®

off

0

Receiver Byy; #0000 kHz

* Sound level is also affected by Windows volume control.

3553008
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13. Click the Define button in the Marker
toolbar to display the Define Markers
control panel.

14. Click Add to add markers as needed.

15. Click the Settings button to return to the
Audio Demod control panel.

16. Set the required receiver bandwidth by
entering a value into the Receiver BW
value entry box.

74

@

Define Markers | Marker Properties | Define Peaks

Reference Delta Markers
Add Marker: MR
Attach to:
{in selected
display)
Al off

Markers Define |+ MR 53-5U Sym To Center E E]

13

[I1 File View |Run Replay Markers Setup Presets Tools Window Help -
T & £ IR | Frequency 488.20 MHz Reflev: 0.00 dBm Presetl | @ Replay - | % Run -
¥ Btmap  [¥IShow Fie:DPX Pulsed

-100.00 dBm
'

Define Markers | Marker Properties | Define Peaks
Reference Delta Markers
Marker:

Attach to:
Delete (in selected
display)

all off

Markers w aloff |Frequency To Center

DPYX Settings | Freq & Span| Bw | Traces | Horiz & vert Scale | Bitmap Scale | Prefs | Density | Audio Demod

B Tune with;  |Marker MR -
Flot: ey "
[Spectum ~] 2udi

Receiver Freq: 91.5 MHz

- -
off Fi 30.000 kHz
Receiver BW: .
(7

Restore o
Defalts Sound lewel is also affected by Windows volurne cojitrol.

D
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17. Set the receiver frequency. [Tl File View Run Replay Markers Setup Presets Tools Window Help 5 x
e . = il= N = AT requency: 428, = eflevt 1, r Preset epla - un =
If you specified a marker with the Tune a3 tT = I; F: Dp,i;,w ZU e e = JR
. n > itmap owe File: Lilse lear
with setting, drag the marker to the comdm N
required frequency. Fine tune the marker 2ol
position with the front-panel knob or o REE

your mouse wheel. If you selected
Frequency control in the Tune with

setting, press the front-panel FREQ “

-100.00 dBm

button, then turn the front-panel knob or © Pas: 488,28 MHz » Scales 10,00 Mz
use the Freq Settlng In the tOOlbar tO Set DPX Settings Freq & Span | 8w | Traces | Hariz & vert Scale | Bitmap Scaie | Prefs | Density | Audio Demad
the required frequency. ot - Tune with:

: on AM
The receiver frequency is displayed as Ay Rerever Freg: 4892 Mz
Receiver Freq between the Tune with o - Recewer s 0000
and Rece'ver BW SettlngS /\ * Sound level is also affected by wWindows volume control,

Makers [ Define | v MR \18éncv - |488.2 Mz To center | [peak | (€] [#] (] [#] [ Tabk |[x |

18. Adjust the Audio Gain setting so you can
hear the demodulated signal. Note that
the sound level is also affected by the
setting of the Windows volume control.
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Index

A

Accessories
optional, 2
power cords, 1
Product Documentation, 1
standard, 1
Acquisition
conflicts, 59
controlling, 58
data source, 26
starting, 39
stopping, 39
Analysis window, 25, 27
Application presets, 30
audio demodulation, 72

C

CF Pan

Touchscreen actions menu, 44
check mark indicator, 58
Cleaning procedures, 13
Conflicts

measurement, 59
Connectors

front panel, 19

rear panel, 20

RF signal input, 38, 39
Controlling acquisitions, 58
Controls

display-specific, 24

front panel, 15

interface, 21
Cooling clearances, 5
correction tables, 69

D

Data

recalling, 50

saving, 48
Default settings, 37
Diagnostics, 12
Digital demodulation displays, 27
Display

conflicts, 59
Display properties

changing, 11
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Display settings
changing, 34
Displays
general signal viewing, 27
GP digital modulation, 27
printing, 46
Pulsed RF, 27
RF measurement, 27
selecting, 29
Documentation, xi
Tektronix part numbers, 1
DPX Density
triggering, 51

E

Environmental specifications, 5
altitude, 5
cooling clearances, 5
humidity, 5
temperature, 5
Extended desktop, 8
external gain/loss correction, 69
External monitor, 8

F

Features, x

File types, 48

Free Run trigger mode, 51

Frequency edge
triggering, 51

Frequency mask
Mask Editor, 56
triggering, 51

Front panel
connectors, 19
controls, 15

G

General signal viewing displays, 27
Graphics driver, 11
Greater than (Mask Test), 64

Incoming inspection, 12
Information messages, 33

Ink saver mode, 47
Input requirements

max DC voltage, 38

max measurable input

power, 38

max safe input power, 38

RF signal range, 38
Installation, 1

network connections, 6
is inside mask (Mask Test), 65
is outside mask (Mask Test), 65
Italicized numbers, 24

K

Key features, x

L

Less than (Mask Test), 64

Maintenance

cleaning procedures, 13

repackaging, 14
Marker toolbar, 43
Markers, 41

absolute, 42

adding, 43

defining, 44

delta, 42

DPX bitmap trace, 42

power, 42

reference, 42
Mask Editor

adding points, 56

editing points, 57
Mask Test, 62

Measurement

conflicts, 59
Mechanical specifications, 5
Messages

on-screen, 33
MR, 42

N

Network connections, 6
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0]

Optional accessories, 2
Options
Power cords, 1

P

Pan

Touchscreen actions menu, 44
Part numbers, manuals, 1
Power cord options, 1
Power level triggering, 51
Power supply, 5
Preset, 37

selecting displays, 30, 32

system settings, 37
Printing, 46

ink saver mode, 47
Product features, x
Pulsed RF displays, 27

R

Real-Time signal analyzer, 25
Rear panel connectors, 20
Recalling data, 50
Repackaging, 14
Reset scale

Touchscreen actions menu, 44
Returning the instrument, 14
RF measurement displays, 27
RF signal connections, 38, 39
RF signal input range, 38
Run control, 40
Run menu, 40
Runt triggering, 52

S

Save options, 48
Saving data, 48
Screens, printing, 46

78

Select
Touchscreen actions menu, 44
Selected window, 58
Selecting displays, 29
Settings
changing, 34
default, 37
preset, 37
Setups
recalling, 50
saving, 48
Software upgrades, xii
installing, 14
Span Zoom
Touchscreen actions menu, 44
Specifications
altitude, 5
cooling clearances, 5
environmental, 5
humidity, 5
input requirements, 38
mechanical, 5
power supply, 5
product dimensions, 5
temperature, 5
Spectrum analyzer
real-time concepts, 25
Standard accessories, 1
power cord, 1
Product Documentation, 1
Standards presets, 32
Starting acquisitions, 39
Stopping acquisitions, 39

T

Test using a mask, 64, 65
Testing signals, 62
Time Qualified

triggering, 52
touchscreen actions menu, 44
Trace legend, 35

Trigger
control panel, 53
mask, 56
violations, 58
Trigger Event parameters, 52
accessing, 53
Triggered trigger mode, 51
Triggering
DPX Density, 51
free run, 51
frequency edge, 51
frequency mask, 51
parameters, 52
power level, 51
Runt, 52
time qualified, 52
triggered mode, 51

U

Upgrade kits, 4
Upgrades
software, xii, 14

vV

Violations
trigger mask, 58

w

Window
analysis, 25
selected, 58

Windows 10, 4

Windows 7, 4

VA

Zoom

Touchscreen actions menu, 44
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